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Preface

Oracle Application Express End User Guide offers an introduction to using Oracle
Application Express applications from an end user's perspective. This guide explains
how to use interactive grids, interactive reports, Websheets, and use applications that
include the ability to upload data.

Audience (page vii)

Documentation Accessibility (page vii)

Related Documents (page vii)

Conventions (page viii)

Audience
Oracle Application Express End User's Guide is intended for end users who are running
Oracle Application Express applications. To use this guide, you must have a general
understanding of relational database concepts and an understanding of the operating
system environment under which you are running Oracle Application Express.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/
topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=trs if you are hearing impaired.

Related Documents
For more information, see these Oracle resources:

• Oracle Application Express Release Notes

• Oracle Application Express Installation Guide

• Oracle Application Express App Builder User’s Guide

• Oracle Application Express Administration Guide

vii
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• Oracle Application Express SQL Workshop Guide

• Oracle Application Express API Reference

• Oracle Application Express Application Migration Guide

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.

viii



Changes in This Release

Changes in Oracle Application Express Release 5.1 (page ix)

Changes in Oracle Application Express Release 5.1
The following are changes in Oracle Application Express End User Guide for Oracle
Application Express release 5.1.

New Features (page ix)

Deprecated and Desupported Features (page ix)

Other Changes (page x)

New Features
The following features are new in this release:

• Interactive Grid

An interactive grid presents users a set of data in a searchable, customizable
report. Functionally, an interactive grid includes customizations capabilities
available in interactive reports plus the ability to rearrange the report interactively
using the mouse. In an editable interactive grid, users can also add to, modify, and
refresh the data set directly on the page. Key features include:

– Full Featured Grid

Includes powerful reporting capabilities, including fixed headers, frozen
columns, scroll pagination, multiple filters, sorting, aggregates, and
computations.

– Extensible and Customizable

Edit text, numerical data, and list of values. Interactive grids support all item
types and item type plug-ins.

See Using Interactive Grids (page 2-1).

Deprecated and Desupported Features
See "Deprecated Features" and "Desupported Features" in Oracle Application Express
Release Notes.
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Other Changes
The following are additional changes in the release:

• All content has been updated to reflect new functionality.

• Screen captures and graphics have been added and updated to reflect the current
Oracle Application Express user interface.
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1
About Oracle Application Express

Browser Requirements (page 1-1)

About Oracle Application Express (page 1-1)
Oracle Application Express is a rapid web application development tool
for the Oracle Database. Through wizards or direct input, developers
can assemble an HTML interface (or application) on top of database
objects. Each application is a collection of linked pages using tabs,
buttons, or hypertext links.

About Database Applications (page 1-2)
A database application is an interactive user interface (UI) that enables
users to display information stored in the Oracle Database and
optionally to add, update, or delete data. This UI can display
information in many formats, including static and interactive reports,
interactive grids, forms, charts, and maps.

About Websheet Applications (page 1-2)
Websheet applications are interactive web pages that combine text with
data. These applications are highly dynamic and defined by their users.

See Also:   

"Quick Start" in Oracle Application Express App Builder User’s Guide

1.1 Browser Requirements
Oracle Application Express supports the current and prior major release of Google
Chrome, Mozilla Firefox, Apple Safari, Microsoft Internet Explorer and Microsoft
Edge.

Note:   

 Microsoft Internet Explorer 11 is the prior major release, with Microsoft Edge
being the current Microsoft browser.

1.2 About Oracle Application Express
Oracle Application Express is a rapid web application development tool for the Oracle
Database. Through wizards or direct input, developers can assemble an HTML
interface (or application) on top of database objects. Each application is a collection of
linked pages using tabs, buttons, or hypertext links.

About Oracle Application Express  1-1



By creating an application, users can manage, manipulate, and display data in the
Oracle Database. Using Oracle Application Express, developers can build two types of
applications:

• Websheet applications

• Database applications

1.3 About Database Applications
A database application is an interactive user interface (UI) that enables users to display
information stored in the Oracle Database and optionally to add, update, or delete
data. This UI can display information in many formats, including static and interactive
reports, interactive grids, forms, charts, and maps.

Using only a web browser and with limited programming experience, Oracle
Application Express enables developers to create powerful database applications.

This guide explains how end users can customize interactive grids and interactive
reports. With an interactive grid or report, end users can customize the appearance of
report data through searching, filtering, sorting, column selection, highlighting, and
other data manipulations. Plus, end users can save their customizations and download
the report locally.

This guide also explains how to import data into an Oracle Application Express
application using an existing application Data Loading Wizard.

See Also:   

• "Using Interactive Grids (page 2-1)"

• "Using Interactive Reports (page 3-1)"

• "Data Loading Wizard Examples (page 4-1)"

1.4 About Websheet Applications
Websheet applications are interactive web pages that combine text with data. These
applications are highly dynamic and defined by their users.

Websheet applications include navigation controls, search capabilities, and the ability
to add annotations such as files, notes, and tags. Websheet applications can be secured
using access control lists and several built-in authentication models.

See Also:   

"Using Websheets (page 5-1)"

About Database Applications
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2
Using Interactive Grids

About Interactive Grids (page 2-1)
An interactive grid presents users a set of data in a searchable,
customizable report. In an editable interactive grid, users can also add
to, modify, and delete the data set directly on the page.

Accessing Interactive Grids (page 2-3)
Access an interactive grid by logging into the database application and
navigating to the interactive grid URL.

Using an Interactive Grid (page 2-4)
Use the interactive grid’s menus and interface to search the grid, add
elements such as filters and computations, reorganize with sort and
breaks, and further customize how the data displays.

Saving Interactive Grids (page 2-37)
Save your changes as a new report within the application. Name and
keep these interactive grid reports Private or make them Public to share
with other users.

Resetting Interactive Grids (page 2-40)
Refresh an interactive grid to pull in the most recent version of the data
in the database. Reset an interactive grid to undo any changes since it
was last saved. Flashback a grid to a point in the past (in minutes) to
retrieve data from the database as it existed at that time, which ignores
any changes made to the data in the database since that time.

Downloading or Emailing an Interactive Grid (page 2-42)
Obtain the data of an interactive grid as a CSV or HTML file by selecting
Download in the Actions menu.

2.1 About Interactive Grids
An interactive grid presents users a set of data in a searchable, customizable report. In
an editable interactive grid, users can also add to, modify, and delete the data set
directly on the page.

Interactive Grid includes numerous capabilities for changing how the data is
displayed. There are new options available in the Actions menu, plus the ability to
rearrange the report interactively using the mouse.
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Interactive Grid Interface

By default, all interactive grids have a search bar, Actions menu, and Reset button.
All grids also have Column Heading Menus, which users access by clicking the name
or heading of a column.

With the Actions and Column Heading menus, users can hide, filter, freeze, highlight,
sort, and create control breaks on individual columns. Advanced users can also define
aggregations, which appear at the bottom of the column or column group.

Users can directly customize the appearance of an interactive grid with the mouse.
Users can resize or drag and drop columns into different places in the grid. The width
and order of columns can also be configured in the Columns dialog.

Users can quickly chart the data with the Chart function. This feature is useful for
quick data visualization or even presentation, and responds immediately to changes in
the data.

Users can quickly revert their modifications with the Reset function, or perform an
incremental revert with the Flashback function. In cases of a highly dynamic data set,
users can use the Refresh function to pull in the latest version of the data on the
database.

About Interactive Grids
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Editable Interactive Grids

Oracle Application Express also contains editable interactive grids, which provide a
more robust tool set for directly editing data in the interactive grid.

Reports in Interactive Grids

End users save modifications to an interactive grid as a report.

See Also:   

• About Editable Interactive Grids (page 2-33)

• About Interactive Grid Report Types (page 2-38)

2.2 Accessing Interactive Grids
Access an interactive grid by logging into the database application and navigating to
the interactive grid URL.

About Interactive Grid URLs (page 2-3)
You can access interactive grids directly with their URL. Interactive grid
URLs contain an application ID and a page ID. When you access an
application page, the session ID also generates in the address bar.

Accessing an Interactive Grid (page 2-4)
Access an interactive grid by navigating to the URL provided by your
application developer. Ensure the URL includes the application ID and
page ID, but not the session state ID.

2.2.1 About Interactive Grid URLs
You can access interactive grids directly with their URL. Interactive grid URLs contain
an application ID and a page ID. When you access an application page, the session ID
also generates in the address bar.

Parts of an Interactive Grid URL

The following is an example of an Interactive Grid URL:

http://apex.somewhere.com/pls/apex/f?p=4350:1:220883407765693447

f?p=
Indicates that you are accessing an Oracle Application Express application.

4350
The application ID. The application ID specifies which application to access.

1
The page ID. The page ID specifies which page to access within the application.
Depending on how the developer configured the page, the page ID may be a word,
such as home.

220883407765693447
The session ID. The Application Express engine uses the session ID to fetch session
state from the database. Oracle Application Express assigns new session IDs during

Accessing Interactive Grids
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authentication processing, records the authenticated user's identity with the session
ID, and continually checks the session ID in each page request's URL or POST data
with the session cookie and the session record in the database.

WARNING:   Do not enter the session ID when you access an interactive grid
URL. Entering information beyond the page ID displays an error.

See Also:   

"About Session IDs" in Oracle Application Express App Builder User’s Guide

2.2.2 Accessing an Interactive Grid
Access an interactive grid by navigating to the URL provided by your application
developer. Ensure the URL includes the application ID and page ID, but not the
session state ID.

If you do not have a URL or the URL does not work, contact the developer.

To access an interactive grid:

1. Click the supplied URL, or enter it in your browser's Address field.

A Login page appears.

2. On the Login page:

a. Username - Enter your username.

b. Password - Enter your password.

c. Click Log In.

Tip:   

The language that displays differs depending upon who creates the
application. For Oracle-supplied applications, including packaged
applications and the Oracle Application Express development environment,
Sign In or Sign out displays. For applications you or your developers create,
Log In or Log out displays.

The interactive grid appears.

See Also:   

"Understanding Session State Management" in Oracle Application Express App
Builder User’s Guide

2.3 Using an Interactive Grid
Use the interactive grid’s menus and interface to search the grid, add elements such as
filters and computations, reorganize with sort and breaks, and further customize how
the data displays.

Using an Interactive Grid
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Searching in an Interactive Grid (page 2-5)
Search an interactive grid by entering criteria into the Search Bar.

Rearranging Columns Using Drag and Drop (page 2-6)
Drag and drop a column into place by clicking and holding the drag
handle on the column heading.

Resizing Columns in an Interactive Grid (page 2-7)
Resize the width of a column by clicking and holding the edge of a
column heading and adjusting it with the mouse.

Sorting Columns in an Interactive Grid (page 2-8)
Specify the alphabetical, numerical, or chronological order of a column
by clicking the Sort Ascending and Sort Descending buttons on the
column heading.

Customizing an Interactive Grid with the Column Heading Menu (page 2-8)
Use the Column Heading menu to quickly customize a column in an
interactive grid.

Customizing an Interactive Grid with the Actions Menu (page 2-16)
Reconfigure and augment how an interactive grid displays data by using
the Actions menu.

Using Charts in an Interactive Grid (page 2-30)
Create a chart in an interactive grid by selecting Chart in the Actions
menu. Edit or remove the chart with the Edit Chart filter.

Editing an Editable Interactive Grid (page 2-32)
Editable interactive grids expand the functionality of regular interactive
grids to enable users to more directly update a grid’s structure and
contents. Users can add and delete rows, edit cell contents, and refresh
the grid with the latest updates.

2.3.1 Searching in an Interactive Grid
Search an interactive grid by entering criteria into the Search Bar.

Tip:   You can also search an interactive grid using a supported browser’s
search function (such as Ctrl + F or Cmd + F).

About the Search Bar (page 2-5)
You can perform text searches with the Search Bar at the top of an
interactive grid.

Using the Select Columns To Search Icon (page 2-6)
Narrow your search parameters by clicking the Select Columns to Search
icon (magnifying glass).

2.3.1.1 About the Search Bar
You can perform text searches with the Search Bar at the top of an interactive grid.

Using an Interactive Grid
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Select Columns to Search icon
Resembles a magnifying glass. Narrows your search.

See "Using the Select Columns To Search Icon (page 2-6)."

Text area
Displays entered search criteria (wildcard characters are implied).

Go button
Executes a search.

2.3.1.2 Using the Select Columns To Search Icon
Narrow your search parameters by clicking the Select Columns to Search icon
(magnifying glass).

To search a specific column:

1. Click the Select Columns to Search icon.

2. Select the name of a column.

3. (Optional) To enable case sensitive searching, select Case Sensitive.

4. Enter a search string in the Search field.

5. Press the Enter key or click Go.

The interactive grid reloads with a filter applied.

To reset the search bar back to the default setting, click the Select Columns to Search
icon and select All Text Columns.

You may need to disable or remove existing filters for broader searching to take effect.

See Also:   

• Disabling a Filter in an Interactive Grid (page 2-23)

• Removing a Filter from an Interactive Grid (page 2-24)

2.3.2 Rearranging Columns Using Drag and Drop
Drag and drop a column into place by clicking and holding the drag handle on the
column heading.

You can also rearrange the order of the columns in the Columns dialog.

To drag and drop a column:

1. Hover the mouse over a column heading to display the drag handle.

 

Using an Interactive Grid
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The mouse cursor also changes when it comes into contact with the drag handle.

2. Click and hold the drag handle.

3. Drag the column to the desired location.

The heading shifts out of place in the row.

4. While holding the mouse, use the indicator to determine which column to place the
dragged column ahead of.

5. Release the mouse.

The column drops into place.

To undo all changes, click the Reset button.

WARNING:   Resetting an interactive grid reverts it to a previously saved state.
Any changes since that time may be lost.

See Also:   Changing the Column Display in an Interactive Grid (page 2-20)

2.3.3 Resizing Columns in an Interactive Grid
Resize the width of a column by clicking and holding the edge of a column heading
and adjusting it with the mouse.

To resize a column with your mouse:

1. Hover your mouse cursor over the edge of column heading until the cursor
changes.

 

 

2. Click and hold the mouse.

3. Move the mouse left and right to achieve the desired width.

4. Release the mouse.

The column resizes.

To undo all changes, click the Reset button.

WARNING:   Resetting an interactive grid reverts it to a previously saved state.
Any changes since that time may be lost.
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2.3.4 Sorting Columns in an Interactive Grid
Specify the alphabetical, numerical, or chronological order of a column by clicking the
Sort Ascending and Sort Descending buttons on the column heading.

To specify the sort order of a column:

1. Hover the mouse in the column heading.

The Sort Ascending and Sort Descending buttons display.

2. Do one of the following:

• To sort a column in ascending order (A to Z, 1 to 9, earliest to latest), click the
Sort Ascending button (up arrow).

• To sort a column in descending order (Z to A, 9 to 1, latest to earliest), click the
Sort Descending button (down arrow).

• To remove an existing sort, click the toggled button again (now labeled Don’t
Sort).

The column sorts.

2.3.5 Customizing an Interactive Grid with the Column Heading Menu
Use the Column Heading menu to quickly customize a column in an interactive grid.
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About the Column Heading Menu in an Interactive Grid (page 2-9)
The Column Heading Menu contains buttons to sort, break, aggregate,
freeze, and hide a column, as well as a text filter for searching within a
column.

Displaying the Column Heading Menu (page 2-11)
Display a column’s Column Heading menu by clicking the heading of
the column.

Creating a Control Break in an Interactive Grid (page 2-11)
Create a break group in an interactive grid by clicking the Control Break
icon in the Column Heading menu.

Creating an Aggregation with the Column Heading Menu (page 2-13)
Quickly apply an aggregation to an interactive grid by clicking the
Aggregate icon in the Column Heading menu.

Freezing Columns in Place (page 2-13)
Freeze a column in place by clicking the Freeze icon in the Column
Heading menu. Freezing a column excludes it from the scrollable area so
that the frozen column is always visible.

Hiding Columns in an Interactive Grid (page 2-14)
Hide a column in an interactive grid from view by clicking the Hide icon
in the Column Heading menu.

Unhiding Columns in an Interactive Grid (page 2-14)
Show a hidden column in an interactive grid by opening the Columns
dialog and enabling it in the Displayed column.

Filtering with the Column Heading Menu (page 2-15)
Filter an interactive grid by the contents of a column by entering
keywords in the Search field of the Column Heading menu.

2.3.5.1 About the Column Heading Menu in an Interactive Grid
The Column Heading Menu contains buttons to sort, break, aggregate, freeze, and
hide a column, as well as a text filter for searching within a column.

Overview

The Column Heading menu contains Sort Order buttons, a Toolbar, a Text Filter, and a
unique list of the column’s contents.
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Sort Order Buttons

The Sort Ascending and Sort Descending buttons appear at the right of every column
heading.

See "Sorting Columns in an Interactive Grid (page 2-8)."

Button Toolbar

The toolbar on the Column Heading menu contains the following buttons and
functions.

Control Break
Creates a Control Break in the interactive grid based on the selected column.

See "Creating a Control Break in an Interactive Grid (page 2-11)."

Aggregate
Opens the Aggregation dialog to define an aggregation against the selected column.

See "Creating an Aggregation in an Interactive Grid (page 2-25)."

Freeze
Freezes the selected column in place, preventing horizontal scrolling.

See "Freezing Columns in Place (page 2-13)."

Hide
Hides the selected column from view.

See "Hiding Columns in an Interactive Grid (page 2-14)."
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Text Filter

The text filter dynamically limits the list of column contents based on the text string
entered into the filter field.

See "Filtering with the Column Heading Menu (page 2-15)."

2.3.5.2 Displaying the Column Heading Menu
Display a column’s Column Heading menu by clicking the heading of the column.

To display a column’s Column Heading menu:

• Click the heading of a column in an interactive grid.

The Column Heading menu displays.

2.3.5.3 Creating a Control Break in an Interactive Grid
Create a break group in an interactive grid by clicking the Control Break icon in the
Column Heading menu.
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Creating a break group pulls the columns out of the interactive grid and displays them
as a master record.

To create a control break:

1. Click the heading of the desired break group column.

The Column Heading menu appears.

2. Click the Control Break icon.

The interactive grid reloads with the control break applied for the selected column,
and a control break filter appears above the grid near the toolbar.

In the following example, a control break has been applied to the interactive grid for
the Project column.

 

 

To remove a control break, click the Remove Control Break icon (X) on the control
break filter.

See Also:   

• About Filters in Interactive Grids (page 2-21)

• Creating a Control Break from the Actions Menu in an Interactive Grid
(page 2-29)
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2.3.5.4 Creating an Aggregation with the Column Heading Menu
Quickly apply an aggregation to an interactive grid by clicking the Aggregate icon in
the Column Heading menu.

To apply an aggregation against a selected column:

1. Click the heading of the column to display the Column Heading menu.

2. Click the Aggregate icon.

The Aggregation dialog appears.

3. Configure the aggregation.

4. Click Save.

The interactive grid reloads with the aggregation applied.

See Also:   "Creating an Aggregation in an Interactive Grid (page 2-25)"

2.3.5.5 Freezing Columns in Place
Freeze a column in place by clicking the Freeze icon in the Column Heading menu.
Freezing a column excludes it from the scrollable area so that the frozen column is
always visible.

To freeze a column in place:

1. Click the heading of the column that you wish to freeze.

The Column Heading menu appears.

2. Click the Freeze icon.

The scroll bar resizes to fit the new scrollable area.
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To unfreeze a frozen column, reopen the Column Heading menu and click the
Unfreeze icon (snowflake).

2.3.5.6 Hiding Columns in an Interactive Grid
Hide a column in an interactive grid from view by clicking the Hide icon in the
Column Heading menu.

To hide a column in an interactive grid:

1. Click the heading of the column to display the Column Heading menu.

2. Click the Hide icon.

The column disappears. Remaining columns shift sideways to fill the space.

To redisplay hidden columns:

3. Click the Actions menu.

4. Select Columns.

The Columns dialog displays.

5. In the Displayed column, select the check box adjacent to the name of the hidden
column.

Tip:   Narrow the list of columns to only the hidden columns by clicking the
Columns icon and selecting Not Displayed.

6. Click Save.

Tip:   

You can also reset the grid to redisplay a hidden column. Resetting an
interactive grid reverts it to a previously saved state. Any changes since that
time may be lost. To reset the grid, click the Reset button.

2.3.5.7 Unhiding Columns in an Interactive Grid
Show a hidden column in an interactive grid by opening the Columns dialog and
enabling it in the Displayed column.
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To show a hidden column in an interactive grid:

1. Click the Actions menu.

2. Select Columns.

The Columns dialog displays.

3. In the Displayed column, select the check box adjacent to the name of the hidden
column.

Tip:   Narrow the list of columns to only the hidden columns by clicking the
Columns icon and selecting Not Displayed.

4. Click Save.

The column appears in the interactive grid.

2.3.5.8 Filtering with the Column Heading Menu
Filter an interactive grid by the contents of a column by entering keywords in the
Search field of the Column Heading menu.
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To filter an interactive grid by column:

1. Click the heading of the column that you wish to sort by.

The Column Heading menu displays.

2. Do one of the following:

• Click within the Filter... text area.

• Press the Tab key until the cursor is within the Filter... text area.

3. Enter the text string you wish to filter by. Wildcards (such as quotation marks) are
valid.

4. Do one of the following:

• Press Enter to execute the filter.

• Select an entry from a list of valid strings that autogenerates when you start
typing.

The interactive grid redisplays with the filter applied.

To remove a filter, click the adjacent Remove Filter icon (X).

See Also:   "Filtering an Interactive Grid (page 2-21)"

2.3.6 Customizing an Interactive Grid with the Actions Menu
Reconfigure and augment how an interactive grid displays data by using the Actions
menu.
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About the Actions Menu in an Interactive Grid (page 2-17)
The Actions Menu appears on the interactive grid toolbar. It contains
functions and submenus for customizing and saving interactive grids.

Changing the Column Display in an Interactive Grid (page 2-20)
Edit which columns display and in what order by selecting Columns in
the Actions menu.

Filtering an Interactive Grid (page 2-21)
Filter an interactive grid by column, row, or both, with text strings and
using operators such as contains and equals.

Selecting Column Sort Order in an Interactive Grid (page 2-25)
Specify the sort order (ascending or descending) of a column by
selecting Sort on the Data submenu. You can also specify how to handle
NULL values.

Defining an Aggregation in an Interactive Grid (page 2-25)
Define an aggregation in an interactive grid by selecting Aggregate from
the Actions, Format submenu. Aggregates display after each control
break and at the end of the interactive grid within the column for which
they are defined.

Adding Highlighting to an Interactive Grid (page 2-28)
Apply color effects to an interactive grid by selecting Highlight in the
Actions, Format submenu.

Creating a Control Break from the Actions Menu in an Interactive Grid
(page 2-29)

Break an interactive grid (that is, compartmentalize the layout) by
column by selecting Control Break in the Actions, Format submenu.

2.3.6.1 About the Actions Menu in an Interactive Grid
The Actions Menu appears on the interactive grid toolbar. It contains functions and
submenus for customizing and saving interactive grids.
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Actions Menu

Columns
Displays the Columns dialog. Toggle which individual columns are visible in the
interactive grid, in what order they appear, and specify their display width (in pixels).

See "Customizing an Interactive Grid with the Column Heading Menu (page 2-8)."

Filter
Displays the Filters dialog. Configure data filters to limit the rows returned.

See "Filtering an Interactive Grid (page 2-21)."

Data
See Data Submenu (below).

Format
See Format Submenu (below).

Chart
Displays the Chart dialog. Create a chart by selecting a chart type and configuring the
required fields.

See "Using Charts in an Interactive Grid (page 2-30)."

Report
See Report Submenu (below).
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Download
Displays the Download dialog. Download or email the interactive grid as a .csv
or .html file.

See "Downloading or Emailing an Interactive Grid (page 2-42)."

Help
Launches a new window containing a summary of how to use interactive grids.

Data Submenu

The Actions Menu also contains the Data submenu. The Data submenu contains the
following options:

Sort
Displays the Sort dialog. Change the columns to sort on and determine whether to
sort in ascending or descending order.

See "Selecting Column Sort Order in an Interactive Grid (page 2-25)".

Aggregate
Displays the Aggregate dialog. Perform mathematical computations against a
column.

See "Defining an Aggregation in an Interactive Grid (page 2-25)".

Flashback
Displays the Flashback dialog. Reload the data as it existed at a previous point in
time.

See "Reverting an Interactive Grid to a Previous State (page 2-42)."

Refresh
Repopulates the interactive grid with the most current data from the database.

See "Refreshing an Interactive Grid (page 2-40)".

Format Submenu

The Actions Menu also contains the Format submenu. The Format submenu contains
the following options:

Highlight
Displays the Highlight dialog. Customize the display colors of a row, column, or
individual cells of a grid. Advanced options are available for repeated values.

See "Adding Highlighting to an Interactive Grid (page 2-28)."

Control Break
Displays the Control Break dialog. Pull the columns out of the grid and display them
as break groups.

See "Creating a Control Break from the Actions Menu in an Interactive Grid
(page 2-29)."

Report Submenu

The Actions Menu also contains the Report submenu. The Report submenu contains
the following options:
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Save
Saves changes to the current interactive grid.

See "Saving Interactive Grids (page 2-37)."

Save As
Displays the Report - Save As dialog. Save a new report of the interactive grid (you
must rename the report and select the report type).

See "Saving Interactive Grids (page 2-37)."

Edit
Displays the Report - Edit dialog. Change the interactive grid report’s name or type,
depending on your privileges.

See "Renaming a Report in an Interactive Grid (page 2-39)."

Delete
Deletes the current view of the interactive grid (not available for Primary reports).

See "Deleting a Report in an Interactive Grid (page 2-40)."

Reset
Resets the interactive grid to the last saved state.

See "Resetting an Interactive Grid (page 2-41)."

2.3.6.2 Changing the Column Display in an Interactive Grid
Edit which columns display and in what order by selecting Columns in the Actions
menu.

To edit how columns display in an interactive grid:

1. Click the Actions menu and select Columns.

The Columns dialog displays.
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2. Edit the columns:

• Displayed - Select the check box to show a column in the grid; deselect a check
box to hide a column in the grid.

• Move Up and Move Down - Adjust the order in which a column appears in
the grid.

• Columns button - Toggle whether the list displays All, Displayed, or Not
Displayed (hidden) columns.

• Minimum Column Width (Pixel) - Adjust the displayed numeric value to
widen or narrow the column (for example, a higher number widens the
column).

3. Click Save.

The interactive grid refreshes.

2.3.6.3 Filtering an Interactive Grid
Filter an interactive grid by column, row, or both, with text strings and using
operators such as contains and equals.

About Filters in Interactive Grids (page 2-21)
You can narrow the contents of an interactive grid by applying a filter to
it. Once applied, filters can be temporarily enabled or disabled or
removed permanently directly in the interactive grid. You can also click
the filter name for quick reconfiguration.

Creating a Row Filter in an Interactive Grid (page 2-22)
Create a row filter to limit the number of rows returned in an interactive
grid. Filtering by row filters for a term in any filterable column.

Creating a Column Filter in an Interactive Grid (page 2-22)
Filter a column in an interactive grid with a specified operator and
value.

Editing a Filter in an Interactive Grid (page 2-23)
Edit a filter by clicking the name of a filter to open the Filters dialog. The
Filters dialog enables you to edit properties of any filter.

Disabling a Filter in an Interactive Grid (page 2-23)
Disable a filter by clicking the check box adjacent to the name of the
filter.

Removing a Filter from an Interactive Grid (page 2-24)
Remove a filter by deleting it in the Filters dialog or by clicking the
adjacent Remove Filter icon (X).

2.3.6.3.1 About Filters in Interactive Grids

You can narrow the contents of an interactive grid by applying a filter to it. Once
applied, filters can be temporarily enabled or disabled or removed permanently
directly in the interactive grid. You can also click the filter name for quick
reconfiguration.
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Existing filters display between the search bar and the grid.

Rather than deleting a filter, you can disable it by deselecting the adjacent checkbox.
You can leave a filter disabled and save your report to preserve it for future usage.

To edit a filter, you can click its name or open the Filters dialog and select it in the list.

You can permanently remove a filter by clicking the adjacent Remove Filter icon (X)
or by removing it from the list in the Filters dialog.

2.3.6.3.2 Creating a Row Filter in an Interactive Grid

Create a row filter to limit the number of rows returned in an interactive grid. Filtering
by row filters for a term in any filterable column.

To add a filter to the rows in an interactive grid:

1. Click the Actions menu.

2. Select Filter.

The Filters dialog displays.

3. In the Filters dialog:

a. Type - Select Row.

b. Search - Enter the text string to filter.

c. Case Sensitive - Enable to make the filter case sensitive.

4. Click Save.

The interactive grid applies the filter.

2.3.6.3.3 Creating a Column Filter in an Interactive Grid

Filter a column in an interactive grid with a specified operator and value.

To add a filter to a column in an interactive grid:
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1. Click the Actions menu.

2. Select Filter.

The Filters dialog displays.

3. In the Filters dialog:

a. Type - Select Column.

b. Column - Choose the column to filter.

c. Operator - Choose the filter logic.

d. Value - Enter the filter criterion.

4. Click Save.

The filter is added to the grid.

2.3.6.3.4 Editing a Filter in an Interactive Grid

Edit a filter by clicking the name of a filter to open the Filters dialog. The Filters dialog
enables you to edit properties of any filter.

To edit an existing filter:

1. Click the name of a filter.

The Filters dialog displays.

2. Edit the filter by selecting new values.

Editable parameters include:

• the filter type (row, column, complex)

• the name of the row or column the filter applies to

• the filter operator

• the filtered value

Other filters can also be added, edited, enabled, and removed in this dialog.

3. To add a new filter:

a. Click the Add button (+) adjacent to the Filters list.

b. Configure the appropriate fields.

4. Click Save to apply your changes.

2.3.6.3.5 Disabling a Filter in an Interactive Grid

Disable a filter by clicking the check box adjacent to the name of the filter.

Disabling a filter is often preferable to deleting it because disabling saves the time of
recreating and reconfiguring the same filter.

• To disable a filter in an interactive grid:
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• Click the check box adjacent to the name of the filter.

The interactive grid reloads and the check box unchecks.

To re-enable the filter, click the check box again.

2.3.6.3.6 Removing a Filter from an Interactive Grid

Remove a filter by deleting it in the Filters dialog or by clicking the adjacent Remove
Filter icon (X).

Tip:   To temporarily disable a filter, deselect the adjacent check box either
within the Filters dialog or above the interactive grid.

To remove a filter, do one of the following:

• Open the Filters dialog and delete it:

1. Click the Actions menu and select Filter.

The Filters dialog appears.

2. In the list of filters, select the filter to remove.

3. Click the Delete button (-).

 

 

4. Click Save.

• Above the interactive grid, click the Remove Filter icon (X) adjacent to a filter.

 

Using an Interactive Grid

2-24  Oracle Application Express End User's Guide



 

2.3.6.4 Selecting Column Sort Order in an Interactive Grid
Specify the sort order (ascending or descending) of a column by selecting Sort on the
Data submenu. You can also specify how to handle NULL values.

To sort by column:

1. Click the Actions menu, select Data, then Sort.

The Sort dialog appears.

2. In the Sort dialog: Select a column, the sort direction (Ascending or Descending),
and the null sorting behavior (Default, Nulls Always Last, or Nulls Always First).

a. Column - Select a column.

b. Direction - Select Descending or Ascending.

c. Nulls - Select First or Last.

3. To add another sort rule, click the Add button (+).

4. Click Save.

The interactive grid reloads.

2.3.6.5 Defining an Aggregation in an Interactive Grid
Define an aggregation in an interactive grid by selecting Aggregate from the Actions,
Format submenu. Aggregates display after each control break and at the end of the
interactive grid within the column for which they are defined.

Creating an Aggregation in an Interactive Grid (page 2-25)
Create an aggregation in an interactive grid by selecting Aggregate in
the Actions, Data submenu.

Editing an Aggregation in an Interactive Grid (page 2-27)
Edit an existing aggregations by selecting the Aggregate in the Actions,
Data submenu.

Removing an Aggregation in an Interactive Grid (page 2-27)
Use the Aggregate dialog to remove an aggregation.

2.3.6.5.1 Creating an Aggregation in an Interactive Grid

Create an aggregation in an interactive grid by selecting Aggregate in the Actions,
Data submenu.

To create an aggregation against a column:

1. Click the Actions menu, select Data, then Aggregate.
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The Aggregation dialog appears. (Some fields may be pre-filled.)

 

 

2. In the Aggregation dialog:

a. Column – Select the column to define against

b. Aggregation – Select the type of aggregation to apply

c. Tooltip – (Optional) Add a label that appears when you hover the mouse over
the aggregation.

d. (Optional) Show Overall Value – Select to display the grand total of a column

3. To add another aggregation:

a. Click the Add icon (+).

A new Aggregation appears in the list.

b. Define the new aggregation as described in the previous step.

4. Click Save.

The result of the aggregation appears at the bottom of the last page of the report.

The following example is an interactive grid with two sum aggregations applied to two
different columns (a control break has also been applied to simplify the presentation):
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2.3.6.5.2 Editing an Aggregation in an Interactive Grid

Edit an existing aggregations by selecting the Aggregate in the Actions, Data
submenu.

To edit an aggregation with the Aggregate dialog:

1. Click the Actions menu.

2. Select the Data submenu, then Aggregate.

The Aggregate dialog displays.

3. Select an aggregation.

4. Edit the aggregation. Editable fields include the column to define against, the
function type, and the Show Grand Total option.

5. Click Save.

2.3.6.5.3 Removing an Aggregation in an Interactive Grid

Use the Aggregate dialog to remove an aggregation.

Tip:   You can delete or disable an aggregation by interacting with the
aggregation filter above the interactive grid. To delete an aggregation, click
the Remove Aggregation icon (X); to disable an aggregation, select the
adjacent check box.

To remove an aggregation with the Aggregation dialog:
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1. Click the Actions menu.

2. Select the Data submenu, then Aggregate.

The Aggregation dialog displays.

3. Do one of the following:

• To hide an aggregation from view in the grid, click the adjacent checkbox in
the Enabled column. This disables the aggregation and stores it for future use
in the Aggregation dialog.
 

 

• To remove the selected aggregation from the grid completely and
permanently, click the Delete icon (—).
 

 

4. Click Save.

2.3.6.6 Adding Highlighting to an Interactive Grid
Apply color effects to an interactive grid by selecting Highlight in the Actions, Format
submenu.

To highlight an interactive grid cell:

1. Click Actions and select Format then Highlight.

The Highlight dialog displays.

2. In the Highlight dialog:

a. Name - Enter the name of the highlight (this name displays as a filter above the
interactive grid).

b. Highlight - Choose the Row or Column to apply the highlight.
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c. Background Color - Select the color of the background in a highlighted cell.
Choose a specific RGB value or a basic color from a list of presets.

d. Text Color - Select the color of the text in a highlighted cell. Choose a specific
RGB value or a basic color from a list of presets.

3. (Optional) In the Highlight dialog, configure advanced highlighting conditions. For
example, to conditionally highlight all tasks with a Status of Closed:

a. Condition Type - Select Column.

b. Column - Select Status.

c. Operator - Select equals.

d. Value - Click the arrow to display the drop-down list of valid values and select
Closed from the drop-down list.

4. To add an additional highlight, click the Add icon (+); click the Delete icon (—) to
remove an existing highlight.

5. Click Save.

2.3.6.7 Creating a Control Break from the Actions Menu in an Interactive Grid
Break an interactive grid (that is, compartmentalize the layout) by column by selecting
Control Break in the Actions, Format submenu.

Creating a break group pulls the columns out of the interactive grid and displays them
as a master record.

To create a control break:

1. Click the Actions menu and select Format then Control Break.

The Control Break dialog displays.

2. In the Control Break dialog:

a. Column - Select the name of the column.

b. Direction - Select the sort direction (Ascending or Descending).

c. Nulls - Select the null sorting behavior (First or Last).

3. Click Save.

The interactive grid reloads with the control break applied for the selected column,
and a control break filter appears above the grid near the toolbar.

In the following example, a control break has been applied to the interactive grid for
the Project column.
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To edit a control break, click the name to display the Control Break dialog. You can
also add, edit, and delete other control breaks in the Control Break dialog.

To remove a control break, click the Remove Control Break icon (X) on the control
break filter.

See Also:   About Filters in Interactive Grids (page 2-21)

2.3.7 Using Charts in an Interactive Grid
Create a chart in an interactive grid by selecting Chart in the Actions menu. Edit or
remove the chart with the Edit Chart filter.

To create a chart from the data in an interactive grid:

1. Click the Actions menu and select Chart.

The Chart dialog appears.

2. Select a chart type.

The dialog populates with options specific to the selected chart type. For example,
a bar chart has a different set of configuration fields than a pie chart. Select
different types to see the range of available options.
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3. Configure the chart settings.

For example, the following is a configuration for a Bar chart:

• Orientation - Select Vertical for the bars to increase toward the top of the chart,
or Horizontal to increase toward the right.

• Label - Select the column to be used as the Label (the label appears beneath or
beside the bar).

• Value - Select the column to be used as the Value (the value is the quantity that
determines the size of the bar).

• Aggregation - (Optional) Select an additional aggregation to be performed on
the column selected for the Value. Valid selections include: Count, Count
Distinct, Minimum, Maximum, Sum, or Average.

4. Click Save.

The chart appears. The following is an example of a bar chart that depicts project
budgets with a sum aggregation. To switch the view between Grid and Chart, click
the toggle that now appears at the top of the interactive grid.
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To reconfigure the chart, click the Edit Chart filter.

To remove a chart, click the Remove Chart icon (X) adjacent to the chart filter.

You can only create one chart at a time in an interactive grid. To create a second chart,
reconfigure the existing chart by clicking Edit Chart, or delete it by clicking the
adjacent Remove Chart icon (X).

See Also:   Filtering an Interactive Grid (page 2-21)

2.3.8 Editing an Editable Interactive Grid
Editable interactive grids expand the functionality of regular interactive grids to
enable users to more directly update a grid’s structure and contents. Users can add
and delete rows, edit cell contents, and refresh the grid with the latest updates.

About Editable Interactive Grids (page 2-33)
Editable interactive grids possess all the same functionality of regular
interactive grids, plus some additional functions in the interface and the
customization menus. You can add, edit, delete, and refresh much of the
underlying data in an editable grid.

Adding a Row in an Editable Interactive Grid (page 2-33)
Click the Add Row button to add a new row to an editable interactive
grid.
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Editing Rows in an Interactive Grid (page 2-34)
Edit rows of an editable interactive grid with the Row Actions Menu,
Edit button, and other functions in the interface.

Deleting a Row in an Interactive Grid (page 2-37)
Use the Row Actions Menu to delete a row from an editable interactive
grid.

2.3.8.1 About Editable Interactive Grids
Editable interactive grids possess all the same functionality of regular interactive
grids, plus some additional functions in the interface and the customization menus.
You can add, edit, delete, and refresh much of the underlying data in an editable grid.

About Editable Interactive Grids

While an interactive grid provides users with a searchable, sortable, and customizable
set of data, with an editable interactive grid you can also change or update the data.
An editable interactive grid allows you to select, add, and change a grid’s contents in
real time, similar to working in spreadsheet software.

Editable Cells

You can change the contents of an individual cell in real time by double-clicking a cell.

You can also toggle the Edit button to enable improved keyboard usability when
updating multiple columns. For example, rather than pointing and clicking on every
cell in the grid, you can use the Tab and Ctrl + Tab keys move focus across cells in a
row.

Editable Rows

The primary way of adding new content to an editable interactive grid is by adding
new rows. You can use the Row Actions menu to edit an individual row, or the
Selection Actions menu to edit multiple rows at once.

2.3.8.2 Adding a Row in an Editable Interactive Grid
Click the Add Row button to add a new row to an editable interactive grid.

Using an Interactive Grid

Using Interactive Grids  2-33



• To add a new row to the top of an editable interactive grid:

• Click the Add Row button.

A blank row appears at the top of the grid or below the currently selected row.

2.3.8.3 Editing Rows in an Interactive Grid
Edit rows of an editable interactive grid with the Row Actions Menu, Edit button, and
other functions in the interface.

About the Row Actions Menu in an Editable Interactive Grid (page 2-34)
The Row Actions Menu appears in editable interactive grids. Users can
quickly edit the rows of an editable grid with functions such as adding,
duplicating, deleting, refreshing, and reverting rows.

About the Edit Button in an Interactive Grid (page 2-36)
The Edit button toggles Editing mode in editable interactive grids. When
enabled, you can single-click a cell for editing; when disabled, you must
double-click a cell for editing.

Editing a Cell in an Interactive Grid (page 2-36)
Double-click a cell in an editable interactive grid to edit the contents.

Editing Multiple Rows in an Editable Interactive Grid (page 2-36)
Select the desired rows of an editable interactive grid to edit, then select
an option from the Selection Actions menu.

2.3.8.3.1 About the Row Actions Menu in an Editable Interactive Grid

The Row Actions Menu appears in editable interactive grids. Users can quickly edit
the rows of an editable grid with functions such as adding, duplicating, deleting,
refreshing, and reverting rows.
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Single Row View
Changes the grid display to a single-page view of a row’s contents. Used for viewing
an individual row in detail, one row at a time. Click the Previous and Next buttons to
navigate between rows in the grid. Click the Report View button to return to the grid.

Add Row
Adds a new row below the current one.

Using an Interactive Grid
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Duplicate Row
Creates a copy of the currently selected row and inserts the copy below the original.

Delete Row
Deletes the row.

Refresh Row
Reloads the row by calling the database and pulling in any updates.

Refresh a row to update it without reloading the entire application page.

Revert Changes
Undoes any changes to the row since the grid was last saved.

See Also:   Editing Multiple Rows in an Editable Interactive Grid (page 2-36)

2.3.8.3.2 About the Edit Button in an Interactive Grid

The Edit button toggles Editing mode in editable interactive grids. When enabled, you
can single-click a cell for editing; when disabled, you must double-click a cell for
editing.

While Editing mode enables quicker editing of multiple cells in succession, it can
impede navigation in larger grids.

2.3.8.3.3 Editing a Cell in an Interactive Grid

Double-click a cell in an editable interactive grid to edit the contents.

To edit the contents of a single cell in an editable interactive grid:

1. Double-click a cell.

Editing mode engages and a cursor displays in the cell.

2. Edit the cell contents.

3. Press Tab or Shift + Tab to edit an adjacent cell in the row or Enter or Shift +
Enter to edit an adjacent cell in the column.

4. To exit editing mode, press Escape.

5. Click Save to save your changes.

Changes to the interactive grid are saved.

2.3.8.3.4 Editing Multiple Rows in an Editable Interactive Grid

Select the desired rows of an editable interactive grid to edit, then select an option
from the Selection Actions menu.

To edit multiple rows in an editable interactive grid:

1. Select rows by selecting check boxes in the check box column.

Tip:   Click the check box in the column heading to select all rows. With all
rows selected, click it again to deselect all rows.

2. In the column heading of the interactive grid, click the Selection Actions menu
icon
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3. Select a valid option. Options include Duplicate, Delete, Refresh, and Revert.

The selected change applies.

2.3.8.4 Deleting a Row in an Interactive Grid
Use the Row Actions Menu to delete a row from an editable interactive grid.

To delete a row from an editable grid:

1. Click the Row Actions menu icon adjacent to the row.

2. Select Delete Row.

The row is crossed out in the grid.
 

 

3. To finalize the deletion, click Save.

The grid reloads with the selected row removed.

2.4 Saving Interactive Grids
Save your changes as a new report within the application. Name and keep these
interactive grid reports Private or make them Public to share with other users.

About Interactive Grid Report Types (page 2-38)
Reports in interactive grids have varying uses and characteristics. End
users interact with the Primary report of an interactive grid, and save
their changes as Private reports.

Saving a Report in an Interactive Grid (page 2-38)
Save your changes to an interactive grid by clicking Save As in the
Actions, Report submenu.

Saving Interactive Grids
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Renaming a Report in an Interactive Grid (page 2-39)
Change the name of an interactive grid report by selecting Edit in the
Actions, Report submenu.

Deleting a Report in an Interactive Grid (page 2-40)
Delete a Private report from an interactive grid by selecting Delete in the
Actions, Report submenu.

2.4.1 About Interactive Grid Report Types
Reports in interactive grids have varying uses and characteristics. End users interact
with the Primary report of an interactive grid, and save their changes as Private
reports.

The following is a list of default report types available to end users in Oracle
Application Express, although developers can choose to add more:

Private Report
Users can save a Private report of the interactive grid to preserve their changes to it
(such as filters, aggregations, column order, visible columns, and other
customizations).

Private reports can only be viewed by the user who creates them.

Primary Report
The default state of an interactive grid is the Primary report.

While users can customize the look and organization of a Primary report, they cannot
overwrite or rename it. The Primary report is useful as a backup or a starting point for
customizing new views of the interactive grid.

Once you save a private report, a drop-down list appears on the toolbar near the
Search bar. You can use this to select between reports.

See Also:   "How the User Type Effects Available Save Options" in the Oracle
Application Express App Builder User’s Guide

2.4.2 Saving a Report in an Interactive Grid
Save your changes to an interactive grid by clicking Save As in the Actions, Report
submenu.

To save a Private interactive grid:

1. Click the Actions menu and select Report then Save As.

The Save As dialog displays.

2. In the Save As dialog:

a. Type - Select Private.

b. Name - Enter a name for the grid.

3. Click Save.

Save further changes to the report by selecting Save in the Actions, Report Setting
submenu.
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The report is saved and a confirmation message displays.

If there is now more than one saved report available in the interactive grid, a drop-
down list appears on the toolbar between the Search Bar and Actions menu.

 

 

2.4.3 Renaming a Report in an Interactive Grid
Change the name of an interactive grid report by selecting Edit in the Actions, Report
submenu.

To rename a report:

1. Select the report from the drop-down list.

2. Click the Actions menu and select Report then Edit.

The Report Settings dialog displays.

Saving Interactive Grids
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3. Rename the report.

4. Click Save.

The report is saved.

2.4.4 Deleting a Report in an Interactive Grid
Delete a Private report from an interactive grid by selecting Delete in the Actions,
Report submenu.

To delete an interactive grid report:

1. Select the report from the drop-down list.

2. Click the Actions menu and select Report then Delete.

A confirmation dialog appears.

3. Click OK.

The report is deleted and the Primary report reloads.

2.5 Resetting Interactive Grids
Refresh an interactive grid to pull in the most recent version of the data in the
database. Reset an interactive grid to undo any changes since it was last saved.
Flashback a grid to a point in the past (in minutes) to retrieve data from the database
as it existed at that time, which ignores any changes made to the data in the database
since that time.

Refreshing an Interactive Grid (page 2-40)
Update an interactive grid with the most current data available on the
database by selecting Refresh in the Actions, Data submenu.

Resetting an Interactive Grid (page 2-41)
Undo changes to an interactive grid by clicking the Reset button or by
selecting Reset from the Actions, Report submenu.

How the Reset Button Affects Saved Interactive Grid Reports (page 2-41)
Clicking the Reset button reloads the grid to the last saved state. This
saved state varies across report types.

Reverting an Interactive Grid to a Previous State (page 2-42)
Revert an interactive grid to a specific point in time by selecting the
Flashback in the Actions, Data submenu.

2.5.1 Refreshing an Interactive Grid
Update an interactive grid with the most current data available on the database by
selecting Refresh in the Actions, Data submenu.

Refreshing an interactive grid is quicker than reloading the entire page in the browser.
Refreshing is also a valuable feature for highly fluid data sets.

To refresh an interactive grid:

1. Click the Actions menu and select Data.

Resetting Interactive Grids
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2. Select Refresh.

The grid refreshes. Updates to the data are applied, but not marked.

2.5.2 Resetting an Interactive Grid
Undo changes to an interactive grid by clicking the Reset button or by selecting Reset
from the Actions, Report submenu.

WARNING:   Resetting an interactive grid reverts it to a previously saved state.
Any changes since that time may be lost.

To reset an interactive grid, do one of the following:

• Click the Reset button.

• Click the Actions menu, select Report, and select Reset.

The grid reloads the last saved state.

2.5.3 How the Reset Button Affects Saved Interactive Grid Reports
Clicking the Reset button reloads the grid to the last saved state. This saved state
varies across report types.

In a Private report, the Reset button undoes only the changes that the user has made
since the last time the user saved the view. Users can Save a report in the Actions,
Report submenu.

In a Primary report, the Reset button undoes all changes that an end user has made—
including reorganization and new content—regardless of the time frame. This is
because end users cannot overwrite Primary reports.

Resetting Interactive Grids
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2.5.4 Reverting an Interactive Grid to a Previous State
Revert an interactive grid to a specific point in time by selecting the Flashback in the
Actions, Data submenu.

To revert an interactive grid:

1. Click the Actions menu, select Data, and select Flashback.

The Flashback dialog displays.

2. Enter the number of minutes into the past that you wish to return to.

3. Click Save.

The grid reloads.

2.6 Downloading or Emailing an Interactive Grid
Obtain the data of an interactive grid as a CSV or HTML file by selecting Download in
the Actions menu.

To download an interactive grid:

1. Click the Actions menu and select Download.

The Download dialog displays.

2. Select CSV or HTML.

3. Do one of the following:

• To download the file, click OK.

Your browser downloads the file.

• To email the file, select the check box Send as Email. Perform the following
steps:

a. Complete the fields for the recipients (Address, Subject, Message).

b. Click Send as Email. The file is sent as an attachment to the email.

Downloading or Emailing an Interactive Grid
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3
Using Interactive Reports

An interactive report is a formatted result of a SQL query.

About Interactive Reports (page 3-1)
In addition to interactive grids, Oracle Application Express includes two
main report types: an interactive report and a classic report.

Accessing Interactive Reports (page 3-2)
An interactive report is contained in a page within a database
application. To access an interactive report you must go to the database
application URL, log in using your account credentials (that is, your
username and password), and then navigate to the report page.

Using the Search Bar (page 3-4)
A search bar displays above interactive reports and includes the
following features.

Using the Select Columns To Search Icon (page 3-4)
The Select columns to search icon displays to the left of the search bar.
Click this icon to display a listing of all columns in the current report.

Using the Column Heading Menu (page 3-5)
Clicking a column heading in an interactive report displays the Column
Heading menu. Positioning the cursor over each icon displays a tooltip
that describes its function.

Using Interactive Report Filters (page 3-6)
When you customize an interactive report, a filter displays between the
search bar and the report.

Customizing an Interactive Report Using the Actions Menu (page 3-6)
Customize an interactive report by selecting options on the Actions
menu.

See Also:   

"Developing Reports" in Oracle Application Express App Builder User’s Guide

3.1 About Interactive Reports
In addition to interactive grids, Oracle Application Express includes two main report
types: an interactive report and a classic report.

The main difference between these two report types is that interactive reports enable
the user to customize the appearance of the data through searching, filtering, sorting,
column selection, highlighting, and other data manipulations.
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About Interactive Reports

The following is an example of an interactive report in the packaged application,
Sample Reporting.

Interactive reports enable end users to create highly customized reports. Users can
alter the report layout by hiding or exposing specific columns and applying filters,
highlighting, and sorting. They can also define breaks, aggregations, charts, group
data, and add their own computations. Once customized, the report can be saved as
either a private or public report. Most interactive reports include a search bar, Actions
menu, Column Heading menu, and edit icons in the first column of each row.

In contrast, classic reports support general keyword search capability, the ability to
specify the number of rows that display, and basic column sorting.

See Also:   

"Utilizing Packaged Applications" in Oracle Application Express App Builder
User’s Guide

3.2 Accessing Interactive Reports
An interactive report is contained in a page within a database application. To access an
interactive report you must go to the database application URL, log in using your
account credentials (that is, your username and password), and then navigate to the
report page.

About Interactive Report URLs (page 3-3)
You can access interactive reports directly with their URL. Interactive
report URLs contain an application ID and a page ID. When you access
an application page, the session ID also generates in the address bar.

Accessing an Interactive Report (page 3-3)
Access an interactive grid by navigating to the URL provided by your
application developer. Ensure the URL includes the application ID and
page ID, but not the session state ID.

Accessing Interactive Reports
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3.2.1 About Interactive Report URLs
You can access interactive reports directly with their URL. Interactive report URLs
contain an application ID and a page ID. When you access an application page, the
session ID also generates in the address bar.

Parts of an Interactive Report URL

The following is an example of an Interactive Report URL:

http://apex.somewhere.com/pls/apex/f?p=4350:1:220883407765693447

f?p=
Indicates that you are accessing an Oracle Application Express application.

4350
The application ID. The application ID specifies which application to access.

1
The page ID. The page ID specifies which page to access within the application.
Depending on how the developer configured the page, the page ID may be a word,
such as home.

220883407765693447
The session ID. The Application Express engine uses the session ID to fetch session
state from the database. Oracle Application Express assigns new session IDs during
authentication processing, records the authenticated user's identity with the session
ID, and continually checks the session ID in each page request's URL or POST data
with the session cookie and the session record in the database.

WARNING:   Do not enter the session ID when you access an interactive report
URL. Entering information beyond the page ID displays an error.

See Also:   

"About Session IDs" in Oracle Application Express App Builder User’s Guide

3.2.2 Accessing an Interactive Report
Access an interactive grid by navigating to the URL provided by your application
developer. Ensure the URL includes the application ID and page ID, but not the
session state ID.

If you do not have a URL or the URL does not work, contact the developer.

To access an interactive report:

1. Click the supplied URL, or enter it in your browser's Address field.

A Login page appears.

2. On the Login page:

Accessing Interactive Reports
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a. Username - Enter your username.

b. Password - Enter your password.

c. Click Log In.

Tip:   

The language that displays differs depending upon who creates the
application. For Oracle-supplied applications, including packaged
applications and the Oracle Application Express development environment,
Sign In or Sign out displays. For applications you or your developers create,
Log In or Log out displays.

The interactive report appears.

See Also:   "Understanding Session State Management" in Oracle Application
Express App Builder User’s Guide

3.3 Using the Search Bar
A search bar displays above interactive reports and includes the following features.

• Select columns to search icon - Resembles a magnifying glass. Click this icon to
narrow your search to specific columns. To search all columns, select All
Columns. See "Using the Select Columns To Search Icon (page 3-4)."

• Text area - Enter case insensitive search criteria (wildcard characters are implied)
and then click Go.

• Go button - Executes a search.

• View Report - Displays alternate default and saved private or public reports. See
"Saving an Interactive Report (page 3-25)."

• View icons - Switches between an icon, report and detail view of the default
report (if enabled). May also include Chart and Group By View (if defined). Icons
do not display by default, but must be configured by the developer.

• Actions menu - Use the Actions menu to customize an interactive report. See
"Customizing an Interactive Report Using the Actions Menu (page 3-6)."

Tip:   

Developers can customize what displays on the Search bar. To learn more, see
"Customizing the Interactive Search Bar" in Oracle Application Express App
Builder User’s Guide.

3.4 Using the Select Columns To Search Icon
The Select columns to search icon displays to the left of the search bar. Click this icon
to display a listing of all columns in the current report.

To search specific columns:

Using the Search Bar
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1. Click the Select columns to search icon and select a column.

2. Enter keywords in the Text area and click Go.

3. To disable the filter, select the Enable/Disable Filter check box.

4. To delete the filter, click the Remove Filter icon.

See Also:   

"Selecting Columns to Display (page 3-10)"

3.5 Using the Column Heading Menu
Clicking a column heading in an interactive report displays the Column Heading
menu. Positioning the cursor over each icon displays a tooltip that describes its
function.

Column Heading menu options include:

• Sort Ascending - Sorts the report by the column in ascending order.

• Sort Descending - Sorts the report by the column in descending order.

• Hide Column - Hides the column. Not all columns can be hidden. If a column
cannot be hidden, the Hide Column icon does not display. To show a hidden
column, select Reset from the Actions menu.

• Control Break - Creates a break group on the column. This pulls the column out of
the report as a master record. See "Creating a Control Break (page 3-13)."

• Column Information - Displays help text about the column, if available.

• Filter - Enter a case insensitive search criteria. Entering a value reduces the list of
values at the bottom of the menu. You can then select a value from the bottom.
The selected value will be created as a filter using either the equal sign (=) or
contains depending on the List of Values Column Filter Type.

Using the Column Heading Menu
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3.6 Using Interactive Report Filters
When you customize an interactive report, a filter displays between the search bar and
the report.

The following illustration shows a report with two filters Project = 'Bug
Tracker' and Status = 'On-Hold'. By default, filters display in the Report
Settings area above the report. You can show or hide the filter details by clicking the
arrow to the left of the filter name.

When you expand a filter and view the details, you can edit it as follows:

• Enable/Disable - To enable and disable a filter, select and deselect the check box
to the left of the filter name.

• Filter Edit - To edit a filter, click the filter name.

• Remove Filter - To remove a filter, select the Remove Filter icon to the right of the
filter name.

3.7 Customizing an Interactive Report Using the Actions Menu
Customize an interactive report by selecting options on the Actions menu.

Tip:   

Not all options described in this section are available on every Actions menu.
Developers can customize what options appear. To learn more, see
"Customizing the Interactive Report Search Bar" in Oracle Application Express
App Builder User’s Guide.

Using Interactive Report Filters

3-6  Oracle Application Express End User's Guide



About the Actions Menu (page 3-8)
The Actions menu appears to the right of the Go button on the Search
bar. Use this menu to customize an interactive report.

Selecting Columns to Display (page 3-10)
Customize a report to include specific columns.

Adding a Filter (page 3-10)
Create row and column filters on an interactive report.

Selecting Column Sort Order (page 3-12)
You can specify column display sort order (ascending or descending) by
selecting Sort on the Data submenu.

Creating a Control Break (page 3-13)
You can create a break group of one or several columns by selecting
Actions, Format, and Control Break.

Adding Highlighting (page 3-13)
Customize the display to highlight specific rows in a report by selecting
Highlight on the Actions, Format submenu.

Computing Columns (page 3-15)
Add mathematical computations (for example, NBR_HOURS/24) or
standard Oracle functions to columns.

Defining an Aggregation Against a Column (page 3-16)
Define an aggregation against a column with the Actions, Data
submenu. Aggregates are displayed after each control break and at the
end of the report within the column for which they are defined.

Creating a Chart from the Actions Menu (page 3-18)
Create charts in an interactive report with the Actions menu. You can
create one chart for each interactive report. Once defined, you can switch
between the chart and report views using buttons on the Search bar.

Grouping Columns (page 3-19)
Group sets of results by one or more columns with Group By, then
perform mathematical computations against the columns. Once you
define the Group By, switch between the group by and report views
using the View Icon on the Search bar.

Managing Pivot Reports (page 3-22)
Pivot reports transpose rows into columns to generate results in a
crosstab format.

Executing a Flashback Query (page 3-24)
Execute a flashback query by selecting Flashback from the Actions, Data
submenu. A flashback query enables you to view the data as it existed at
a previous point in time.

Saving an Interactive Report (page 3-25)
Save a private or public interactive report. Only the user who creates a
private report can view, save, rename, or delete that private report.

Resetting a Report (page 3-28)
Reset a report back to the default settings by selecting Reset from the
Actions, Report submenu. Resetting a report removes any
customizations you have made.

Customizing an Interactive Report Using the Actions Menu
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Downloading a Report (page 3-28)
Download an interactive report by selecting Download from the Actions
menu.

Subscribing to Report Updates by Email (page 3-28)
Subscribe to an interactive report to receive updated versions it.

3.7.1 About the Actions Menu
The Actions menu appears to the right of the Go button on the Search bar. Use this
menu to customize an interactive report.

Actions Menu

The Actions menu contains the following options:

Columns
Specifies which columns to display and in what order. See "Selecting Columns to
Display (page 3-10)."

Filter
Focuses the report by adding or modifying the filter clause on the query. See "Adding
a Filter (page 3-10)."

Data
Contains the Data submenu (see below).

Customizing an Interactive Report Using the Actions Menu
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Format
Contains the Format submenu (see below).

Chart
Displays the report data as a chart. See "Creating a Chart from the Actions Menu
(page 3-18)."

Group By
Enables users to group the result set by one or more columns and perform
mathematical computations against columns. See "Grouping Columns (page 3-19)."

Pivot
Enables users to define a Pivot report. See "Managing Pivot Reports (page 3-22)."

Report
Contains the Report submenu.

Manage your private and public reports of the interactive grid.

Saves the interactive report. Depending upon their user credentials, users can save
different types of reports. See "Saving an Interactive Report (page 3-25)."

Revert the grid to its last saved state with the Reset function.

Reset
Resets the report back to the default report settings. See "Resetting a Report
(page 3-28)."

Download
Downloads a report. Available download formats depend upon your installation and
report definition. See "Downloading a Report (page 3-28)."

Subscription
Send an interactive report by email. See "Subscribing to Report Updates by Email
(page 3-28)."

Help
Provides descriptions of how to customize interactive reports.

Data Submenu

The Actions Menu also contains the Data submenu. The Data submenu contains the
following options:

Sort
Changes the columns to sort on and determines whether to sort in ascending or
descending order. See "Selecting Column Sort Order (page 3-12)."

Aggregate
Enables users to perform mathematical computations against a column. See "Defining
an Aggregation Against a Column (page 3-16)."

Compute
Enables users to add computed columns to a report. See "Computing Columns
(page 3-15)."

Customizing an Interactive Report Using the Actions Menu
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Flashback
Enables users to view the data as it existed at a previous point in time. See "Executing
a Flashback Query (page 3-24)."

Format Submenu

The Actions Menu also contains the Format submenu. The Format submenu contains
the following options:

Control Break
Creates a break group on one or several columns. This pulls the columns out of the
interactive report and displays them as a master record. See "Creating a Control Break
(page 3-13)."

Highlight
Defines a filter that highlights the rows that meet the filter criteria. See "Adding
Highlighting (page 3-13)."

3.7.2 Selecting Columns to Display
Customize a report to include specific columns.

To use the Select Columns option:

1. Click the Actions menu and select Columns.

The Select Columns dialog appears.

2. Select the columns you want to move. Click the center arrows to move a column
from Display in Report to Do Not Display. To select multiple columns at once,
press and hold the CTRL key.

3. To change the order of the columns, click the Top, Up, Down, and Bottom arrows
on the right.

4. Click Apply.

A revised report appears.

See Also:   

"Resetting a Report (page 3-28)"

3.7.3 Adding a Filter
Create row and column filters on an interactive report.

About Creating Filters (page 3-11)
You can create a filter on an interactive report by adding or modifying
the WHERE clause on the query.

Adding, Editing, and Removing a Column Filter (page 3-11)
Use the Actions menu to add, edit, or remove a column filter in an
interactive report.

Customizing an Interactive Report Using the Actions Menu
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Adding, Editing, and Removing a Row Filter (page 3-12)
Use the Actions menu to add, edit, or remove a row filter in an
interactive report.

3.7.3.1 About Creating Filters
You can create a filter on an interactive report by adding or modifying the WHERE
clause on the query.

You can create two types of filters:

• Column - Creates a custom column filter. Select a column, select a standard
Oracle operator (=, !=, not in, between), and enter an expression to compare
against. Expressions are case sensitive. Use the percent sign (%) as a wildcard.
Note that the selected column does not need to be one that currently displays. For
example:

STATE_NAME like A%

• Row - Creates a custom row filter. This filter creates a complex WHERE clauses
using column aliases and any Oracle functions or operators. For example:

 G = 'VA' or G = 'CT'

Where G is the alias for CUSTOMER_STATE.

3.7.3.2 Adding, Editing, and Removing a Column Filter
Use the Actions menu to add, edit, or remove a column filter in an interactive report.

To add a column filter:

1. Click the Actions menu and select Filter.

The Filter dialog appears.

2. For Filter Type, select Column.

3. In the Filter region, specify a column, an operator, and an expression and click
Apply.

Notice the filter that displays in the Report Settings area above the report. You can
show or hide the filter details by clicking the arrow to the left of the filter name.

Customizing an Interactive Report Using the Actions Menu
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To revise the filter:

4. Click the filter name (in this example, Project = 'Discussion Forum').

5. Edit your selections and click Apply.

6. To disable the filter, select the Enable/Disable Filter check box.

7. To delete the filter, click Remove Filter.

3.7.3.3 Adding, Editing, and Removing a Row Filter
Use the Actions menu to add, edit, or remove a row filter in an interactive report.

To add a row filter:

1. Click the Actions menu and select Filter.

The Filter dialog appears.

2. For Filter Type, select Row.

3. In the Filter dialog:

a. Name - Enter a name that describes this filter.

b. Filter Expression - Enter an expression. Select a column and function or operator
at the bottom of the region. For example, I >=2500 displays projects costing
more than $5000.

c. Click Apply.

Notice the filter that displays in the Report Settings area above the report. You
can show or hide the filter details by clicking the arrow to the left of the filter
name.

4. To revise the filter:

a. Click the filter name.

b. Edit your selections and click Apply.

5. To disable the filter, select the Enable/Disable Filter check box.

6. To delete the filter, click Remove Filter.

3.7.4 Selecting Column Sort Order
You can specify column display sort order (ascending or descending) by selecting Sort
on the Data submenu.

You can also specify how to handle NULL values. Using the default setting always
displays NULL values last or always displays them first.

To sort by column:

1. Click the Actions menu and select Data and then Sort.

The Sort dialog appears.

2. Select a column, the sort direction (Ascending or Descending), and Null Sorting
behavior (Default, Nulls Always Last, or Nulls Always First).
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3. Click Apply.

3.7.5 Creating a Control Break
You can create a break group of one or several columns by selecting Actions, Format,
and Control Break.

Creating a break group pulls the columns out of the interactive report and displays
them as a master record.

To create a break group:

1. Click the Actions menu and select Format and then Control Break.

The Control Break dialog appears.

2. Select a column and then a status (Enable or Disable).

3. Click Apply.

A revised report displays.

Note the defined filter displays in the Report Settings area above the report.

4. Click the left arrow to expand the filter.

5. To disable the Control Break filter, deselect the Enable/Disable Filter check box. To
activate a disabled filter, select the Enable/Disable Filter check box again.

6. To delete the filter, click Remove Control Break.

3.7.6 Adding Highlighting
Customize the display to highlight specific rows in a report by selecting Highlight on
the Actions, Format submenu.

To add highlighting:

1. Click the Actions menu and select Format and then Highlight.
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The Highlight dialog appears.

2. Edit the following information:

a. Name - Enter a name that describes this filter.

b. Sequence - Enter a numeric value to identify the sequence in which highlighting
rules are evaluated.

c. Enabled - Select Yes.

d. Highlight Type - Select Cell or Row.

e. Background Color - Select a new color for the background of the highlighted
area.

f. Text Color - Select a new color for the text in the highlighted area.

g. Highlight Condition - Select a column, an operator, and expression.

h. Click Apply.
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Tip:   Note the highlight On-Hold Projects displays in the Report Settings
area above the report. You can show or hide the filter details by clicking the
arrow to the left of the filter name.

3. To revise the highlight, click the highlight name and make the following edits:

a. Background Color - Select yellow.

b. Text Color - Select red.

c. Click Apply.

4. To disable the highlight, select the Enable/Disable check box.

5. To delete the highlight, click Remove Highlight.

3.7.7 Computing Columns
Add mathematical computations (for example, NBR_HOURS/24) or standard Oracle
functions to columns.

Creating a Computation (page 3-15)
Use the Compute function in the Actions, Data submenu to add a
computation to a column.

Deleting a Computation (page 3-16)
Open the Compute dialog to remove a computation.

3.7.7.1 Creating a Computation
Use the Compute function in the Actions, Data submenu to add a computation to a
column.

To create a computation:

1. Click the Actions menu and select Data and then Compute.

The Compute dialog appears.

2. In the Compute dialog:

a. Computation - Select New Computation.
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b. Column Heading - Enter the name of the new column to be created.

c. Format Mask - Select an Oracle format mask to be applied to the new column.
(For example, $5,234.10).

3. Create the computation:

a. Columns - Select a column or alias.

b. Keypad - Select a shortcut for commonly used keys.

c. Functions - Select the appropriate function.

In the following example, a new column compares the actual cost to the budgeted
amount, using the formula I - H, where I is the budgeted amount and H is the
cost.

4. Click Apply.

The revised report appears containing a new Cost Analysis column.

3.7.7.2 Deleting a Computation
Open the Compute dialog to remove a computation.

To delete a computation:

1. Click the Actions menu and select Data and then Compute.

The Compute dialog appears.

2. From Computation, select the computation.

The computation appears.

3. Click Delete.

3.7.8 Defining an Aggregation Against a Column
Define an aggregation against a column with the Actions, Data submenu. Aggregates
are displayed after each control break and at the end of the report within the column
for which they are defined.
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Creating an Aggregation Against a Column (page 3-17)
Create an aggregation by selecting Aggregate in the Actions, Data
submenu.

Removing a Column Aggregation (page 3-18)
Open the Aggregate dialog to remove an aggregation.

3.7.8.1 Creating an Aggregation Against a Column
Create an aggregation by selecting Aggregate in the Actions, Data submenu.

To create an aggregation against a column:

1. Click the Actions menu and select Data and then Aggregate.

The Aggregate dialog appears.

2. In the Aggregate dialog:

a. Aggregation - Select New Aggregation.

b. Function - Select one of the following: Sum; Average, Count, Count Distinct,
Minimum, Maximum, or Median.

c. Column - Select a column.

This example creates a sum of the Cost column.

d. Click Apply.

The computation appears at the bottom of the last page of the report. In this
example, the aggregate shows the sum of all amounts in the Cost column.
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3.7.8.2 Removing a Column Aggregation
Open the Aggregate dialog to remove an aggregation.

To remove column aggregation:

1. Click the Actions menu and select Data and then Aggregate.

The Aggregate dialog appears.

2. From Aggregation, select a previously defined aggregation.

3. Click Delete.

3.7.9 Creating a Chart from the Actions Menu
Create charts in an interactive report with the Actions menu. You can create one chart
for each interactive report. Once defined, you can switch between the chart and report
views using buttons on the Search bar.

Creating a Chart (page 3-18)
Use the Chart function in the Actions menu to create a chart in an
interactive report.

Editing a Chart (page 3-19)
Open the Chart dialog to edit a chart in an interactive report.

Deleting a Chart (page 3-19)
Open the Chart dialog to remove a chart in an interactive report.

3.7.9.1 Creating a Chart
Use the Chart function in the Actions menu to create a chart in an interactive report.

To create a chart:

1. Click the Actions menu and select Chart.

The Chart dialog appears.

2. In the Chart dialog, specify the appropriate options.

a. Chart Type - Select the type of chart you want to create (horizontal bar, vertical
bar, pie, or line).

b. Label - Select the column to be used as the label.

c. Axis for Title for Label - Enter the title to display on the axis associated with the
column selected for Label (not available for pie chart)

d. Value - Select the column to be used as the Value. If your function is a COUNT, a
Value does not need to be selected.

e. Axis Title for Value - Enter the title to display on the axis associated with the
column selected for Value (not available for pie chart).

f. Function - (Optional) Select a function to be performed on the column selected
for Value.

g. Sort - Select a sorting method.
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3. Click Apply.

The chart appears.

Tip:   

The Search bar now contains two icons: View Report and View Chart. Click
these icons to toggle between chart and report views.

3.7.9.2 Editing a Chart
Open the Chart dialog to edit a chart in an interactive report.

To edit a chart:

1. While viewing a report:

a. Click the Actions menu and select Chart.

The Chart dialog appears.

b. Edit your selections and click Apply.

2. While viewing a chart:

a. Click Edit Chart.

b. Edit your selections and click Apply.

3.7.9.3 Deleting a Chart
Open the Chart dialog to remove a chart in an interactive report.

To delete a chart:

1. While viewing a report:

a. Click the Actions menu and select Chart.

The Chart dialog appears.

b. Click Delete.

2. While viewing a chart:

a. Click Edit Chart.

b. Click Delete.

Tip:   

You can also click the Remove Chart icon to the right of the Edit Chart filter.

3.7.10 Grouping Columns
Group sets of results by one or more columns with Group By, then perform
mathematical computations against the columns. Once you define the Group By,
switch between the group by and report views using the View Icon on the Search bar.

Creating a Group By (page 3-20)
Use the Group By function in the Actions menu to reorganize an
interactive grid.
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Editing a Group By (page 3-21)
Edit the properties of a grouping in the Goup By dialog.

Selecting a Group By Sort Order (page 3-21)
Specify group by column sort order (ascending or descending) by either
clicking on the group by column heading or selecting Group By Sort on
the Actions menu.

Deleting a Group By (page 3-22)
Delete a grouping in the Group By dialog.

3.7.10.1 Creating a Group By
Use the Group By function in the Actions menu to reorganize an interactive grid.

To use Group By:

1. Click the Actions menu and select Group By.

The Group By dialog appears.

2. In the Group by dialog:

a. Select a column to display. To add additional columns, click Add Group By
Column.

b. Select the function, column, label, and format mask. To create a sum, click the
Sum check box. To add another function, click Add Function.

c. Click Apply.
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A Group By icon appears to the left of the Actions menu. The resulting report displays
the Project, Task Name, and Budget columns. Additionally, a new column, Total Cost,
displays on the right side.

3.7.10.2 Editing a Group By
Edit the properties of a grouping in the Goup By dialog.

To edit a group by:

1. Click Edit Group By.

The Group By dialog appears.

2. Edit the attributes.

3. To remove a previously defined Group by Column, select the default setting Select
Group By Column.

4. Click Apply.

3.7.10.3 Selecting a Group By Sort Order
Specify group by column sort order (ascending or descending) by either clicking on
the group by column heading or selecting Group By Sort on the Actions menu.

You can also specify how to handle NULL values. Using the default setting always
displays NULL values last or always displays them first.

To sort a group by column:

1. Access a Group By view.

2. Click the Actions menu and select Group By Sort.

Tip:   

The Group By Sort menu is only visible when you are viewing Group By
view.

The Group By Sort dialog appears.

3. Select a column, the sort direction (Ascending or Descending), and Null Sorting
behavior (Default, Nulls Always Last, or Nulls Always First).
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4. Click Apply.

See Also:   Creating a Group By (page 3-20)

3.7.10.4 Deleting a Group By
Delete a grouping in the Group By dialog.

To delete a group by:

1. Click Edit Group By.

The Group By dialog appears.

2. Click Delete.

Tip:   

You can also click the Remove Group By icon to the right of the Edit Group By
filter.

3.7.11 Managing Pivot Reports
Pivot reports transpose rows into columns to generate results in a crosstab format.

Select pivot columns and rows and then provide the functions to be represented in the
pivot report. Once created, pivot reports display a new icon in the search bar.

Creating a Pivot Report (page 3-22)
Create a pivot report by opening the Pivot dialog from the Actions
menu.

Editing a Pivot Report (page 3-23)
Edit a pivot report by clicking the Edit Pivot filter in an interactive report
and opening the Pivot dialog.

Deleting a Pivot Report (page 3-23)
Remove a pivot report from an interactive report in the Pivot dialog.

3.7.11.1 Creating a Pivot Report
Create a pivot report by opening the Pivot dialog from the Actions menu.

To create a pivot report:

1. Click the Actions menu and select Pivot.

The Pivot dialog appears.

2. In the Pivot dialog:

a. Pivot Columns - Select the columns to display (for example, Status). To add
additional columns, click Add Pivot Column.

b. Row Columns - Select the rows to display (for example, Project). To add
additional columns, click Add Row Column.

c. Computation:
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• Select a function, column, label, and format mask.

• To create a sum, click the Sum check box (optional).

d. Click Apply.

The following example shows a Pivot report that displays the number of closed, on-
hold, open, and pending tasks associated with each project.

3.7.11.2 Editing a Pivot Report
Edit a pivot report by clicking the Edit Pivot filter in an interactive report and opening
the Pivot dialog.

To edit a pivot report:

1. Click the Edit Pivot filter.

The Pivot dialog appears.

2. Edit the attributes.

3. To remove a previously defined column or row, select the default setting, Select
Pivot Column and Select Row Column.

4. Click Apply.

3.7.11.3 Deleting a Pivot Report
Remove a pivot report from an interactive report in the Pivot dialog.

To delete a pivot report:

1. Click the Edit Pivot filter.

The Pivot dialog appears.

2. Click Delete.
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Tip:   

You can also click the Remove Pivot icon to the right of the Edit Pivot filter.

3.7.12 Executing a Flashback Query
Execute a flashback query by selecting Flashback from the Actions, Data submenu. A
flashback query enables you to view the data as it existed at a previous point in time.

The default amount of time that you can flashback is 3 hours (or 180 minutes) but the
actual amount is different for each database.

Creating a Flashback Query (page 3-24)
Create a flashback query by using the Actions, Data submenu.

Editing a Flashback Query (page 3-24)
Edit a flashback query by clicking the flashback query filter in an
interactive report.

Deleting a Flashback Query (page 3-24)
Delete a flashback query by using the flashback query filter dialog in an
interactive report.

3.7.12.1 Creating a Flashback Query
Create a flashback query by using the Actions, Data submenu.

To execute a flashback query:

1. Click the Actions menu and select Data thenFlashback.

2. In the Flashback field, enter the number of minutes.

3. Click Apply.

3.7.12.2 Editing a Flashback Query
Edit a flashback query by clicking the flashback query filter in an interactive report.

To edit a flashback query:

1. Click flashback query filter.

The Flashback dialog appears.

2. Edit minute ago attribute.

3. Click Apply.

3.7.12.3 Deleting a Flashback Query
Delete a flashback query by using the flashback query filter dialog in an interactive
report.

To delete a flashback query:

1. Click the flashback query filter.

The Flashback dialog appears.

2. Click Delete.
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Tip:   

You can also click the Remove Flashback icon to the right of the flashback
query filter.

3.7.13 Saving an Interactive Report
Save a private or public interactive report. Only the user who creates a private report
can view, save, rename, or delete that private report.

About the Report List (page 3-25)
You can view different versions of an interactive report by selecting
from a drop-down list of default or primary reports and private reports.

About Configuration Dependencies (page 3-26)
The ability to save an interactive report is configurable by the
application developer who creates the interactive report.

Saving a Public or Private Interactive Report (page 3-26)
End users can save an interactive report and classify it as Public or
Private.

Renaming a Public or Private Interactive Report (page 3-27)
Rename a public or private report that you have created by clicking its
report name.

Deleting a Public or Private Interactive Report (page 3-27)
Remove a public or private report that you have created by clicking its
Remove Report icon.

3.7.13.1 About the Report List
You can view different versions of an interactive report by selecting from a drop-down
list of default or primary reports and private reports.

The following illustration shows the Reports list on the Search bar of an interactive
report.

This example shows two reports:

Default - Primary Report
This is the initial report created by the application developer. Default, Primary reports
cannot be renamed or deleted.
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Private - 1. Open Projects
This is a Private report. Only the user who creates a private report can view, save,
rename, or delete it.

3.7.13.2 About Configuration Dependencies
The ability to save an interactive report is configurable by the application developer
who creates the interactive report.

See Also:   

• "Customizing the Search Bar" in Oracle Application Express App Builder User’s
Guide

• "Saving an Interactive Report" in Oracle Application Express App Builder
User’s Guide

3.7.13.3 Saving a Public or Private Interactive Report
End users can save an interactive report and classify it as Public or Private.

Public
The report can be saved, renamed, or deleted by the end user who created it. Other
users can view and save the layout as another report.

Private
Only the end user that created the report can view, save, rename or delete the report.

To save a public or private interactive report:

1. Go to the page containing the interactive report you want to save.

2. Customize the report (for example, hide columns, add filters, and so on).

3. Click the Actions menu and select Report then Save Report.

The Save Report dialog appears.

4. In Save Report:

a. Select either As Named Report or As Default Report Settings option.

Tip:   

This option is available for only developers.
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b. Name - Enter a name for the report.

c. Description - Enter an optional description.

d. Public - Select this check box to make the report viewable to all users. Deselect
this check box to make the report private.

Tip:   

The ability to save an interactive report as Public is determined by your
application developer.

e. Click Apply.

See Also:   

• Customizing an Interactive Report Using the Actions Menu (page 3-6)

• About Configuration Dependencies (page 3-26)

3.7.13.4 Renaming a Public or Private Interactive Report
Rename a public or private report that you have created by clicking its report name.

To rename a public or private interactive report:

1. Select a public or private interactive report to rename.

2. Click the report name link.

3. Edit the attributes (for example, enter a new name).

4. Click Apply.

3.7.13.5 Deleting a Public or Private Interactive Report
Remove a public or private report that you have created by clicking its Remove Report
icon.

To delete a public or private interactive report:

1. Click the Remove Report icon next to the report name link.

2. Click Apply.
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3.7.14 Resetting a Report
Reset a report back to the default settings by selecting Reset from the Actions, Report
submenu. Resetting a report removes any customizations you have made.

To reset a report:

1. Click the Actions menu and select Report then Reset.

2. Click Apply.

Tip:   

You can also reset a report by clicking the Reset Report button in the Search
Bar.

3.7.15 Downloading a Report
Download an interactive report by selecting Download from the Actions menu.

Available download formats depend upon your installation and report definition.
Supported formats include comma-delimited file (CSV) format, HTML, Email,
Microsoft Excel (XLS) format, Adobe Portable Document Format (PDF), and Microsoft
Word Rich Text Format (RTF).

To download a report:

1. Click the Actions menu and select Download.

2. Select a report download format and follow the provided instructions.

Tip:   

The ability to download an interactive report is configurable by your
application developer.

See Also:   "Configuring Download Options on the Actions Menu" in Oracle
Application Express App Builder User’s Guide

3.7.16 Subscribing to Report Updates by Email
Subscribe to an interactive report to receive updated versions it.

How Report Subscriptions Work (page 3-29)
You can subscribe to a report by clicking Subscription on the Actions
menu.

Subscribing to Updated Report Results (page 3-29)
Subscribe to a report by selecting Subscription in the Actions menu.

See Also:   

"Managing Interactive Report Subscriptions" in Oracle Application Express
Administration Guide
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3.7.16.1 How Report Subscriptions Work
You can subscribe to a report by clicking Subscription on the Actions menu.

Emails sent from an interactive report contain a system generated email signature that
cannot be overwritten that identifies who originated the email.

To use Subscription:

• An Oracle Application Express administrator must configure email at the Instance
level.

• The application developer configure enable the Subscription check box on the
Interactive Report Attributes page.

See Also:   

"Customizing the Interactive Report Search Bar" in Oracle Application Express
App Builder User’s Guide

3.7.16.2 Subscribing to Updated Report Results
Subscribe to a report by selecting Subscription in the Actions menu.

Note:   

Emails sent from a subscription include a system generated email signature
indicating who created the subscription. This signature cannot be removed.

To receive updated report results by email:

1. Click the Actions menu and select Subscription.

The Subscription dialog appears.

2. Under Subscription:

a. Email Address - Enter the email addresses to receive the report. To include
multiple email addresses, separate each email address with a comma.

b. Subject - Enter text to display in the email subject line.

c. Frequency - Select the interval at which the report is sent.

d. Starting From - Select a start date and time.

e. Ending - Select an end date and time. Select a day, week, month, or year.

f. Click Apply.
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4
Data Loading Wizard Examples

You can import data into an Oracle Application Express application using an existing
application Data Loading Wizard.

Tip:   

To use the functionality described in this section, your application must be
built with Data Upload capability. To learn more, see "Creating Applications
with Data Loading Capability" in Oracle Application Express App Builder User’s
Guide.

About Using the Data Loading Wizard (page 4-1)
End users can run a Data Load Wizard that uploads data from a file or
copies and pastes data entered by the end user directly into the wizard.

Importing Data from a File into Your Application (page 4-2)
Use the Data Load Wizard to import data into your application from a
file, such as a text file.

Copying and Pasting Data into Your Application (page 4-5)
Use the Data Load wizard to copy and paste data from a file, such as a
text file.

4.1 About Using the Data Loading Wizard
End users can run a Data Load Wizard that uploads data from a file or copies and
pastes data entered by the end user directly into the wizard.

Applications with data loading capability enable end users to directly import data into
a table which has been configured by the application developer.

The Data Loading wizard for your application may have been built to include the
ability to apply table lookup and transformation rules during the data upload process.
Before the data is actually imported into the database, you can preview the data after
all look up and transformation rules have been applied.

• Table Lookups - These rules automatically map data in the import file or copy
and paste field to data that is found in another table. For example, if the import
file contains a department name for the DEPTNO column but the upload table
requires a number for that column, use a table lookup rule to find the
corresponding department number for that department name in another table.

• Data transformation rules - These rules automatically perform formatting
transformations such as changing import data to uppercase, lowercase, and so on.
For example, if the import file includes column data with both upper and
lowercase and the destination table requires all uppercase, data transformation
rules can automatically insert only uppercase into that column during data
upload.
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4.2 Importing Data from a File into Your Application
Use the Data Load Wizard to import data into your application from a file, such as a
text file.

This procedure includes examples from the sample packaged application, Sample
Database Application.

To upload data to your application, the application must have been built with Data
Upload capability and the file must be formatted properly.

To upload data from a file:

1. Run the sample packaged application, Sample Database Application.

2. On the Customers page, click Upload Data.

The Data Load wizard appears. Next, select how to upload data.

3. For Import From, select Upload file, comma separated (*.csv) or tab delimited.

4. Under Data Load Source:

a. File Name - Browse to the file name containing the data to upload.
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Tip:   

To create a text file with sample data, copy and paste the data shown at the
top of the page into a text file. If you use this sample data, remember to enter a
comma (,) in the Separator attribute.

b. Separator - Enter the column separator character. Enter a comma (,) for comma
separators or \t for tab separators.

c. Optionally Enclosed By - Enter a delimiter character.

Use this character to delineate the starting and ending boundary of a data value.
If you specify a delimiter character, Data Workshop ignores whitespace
occurring before the starting and ending boundary of a data value. You can also
use this option to enclose a data value with the specified delimiter character.

d. First Row has Column Names - Select this option if your data contains column
names in the first row.

e. Optionally select Use Advanced Settings and configure the following
attributes:

• Decimal Character - Enter a decimal character to separate the integer and
decimal parts of a number. To learn more, see field-level Help.

• Group Separator - Enter a group separator to separate integer groups. Any
non-numeric character can function as the group separator with a few
exceptions. To learn more, see field-level Help.

• Currency Symbol - If your data contains an international currency symbol,
enter it here. See field-level Help for examples.

• File Character Set - Select the file character set associated with the file to be
uploaded.

• Date / Number Formats to use - Select Use application standard format
masks to use the Application Date and Timestamp formats during data
loading or Provide custom formats for uploaded columns to input your
own.

f. Click Next.

The Data/Table Mapping page appears.

Importing Data from a File into Your Application
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5. For Data/Table Mapping:

a. Target Column - Indicates the destination column name. To change the column
name, select a new column name from the list. To hide a column, select Do Not
Load.

b. Click Next.

The Data Validation page appears showing the data to be inserted or updated after
any table lookup and transformation rules have been applied.

6. Review the data to be uploaded and click Load Data.

The Data Load Results page displays:

• Inserted Row(s) - This is the number of new rows uploaded to the table.
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• Updated Row(s) - This is the number of rows in the table updated with new
information.

• Failed Row(s) - This is the number of rows from the upload file that were not
added or updated.

• To be Reviewed Row(s) - This is the number of rows needing review.

7. Click Finish.

See Also:   

• About Using the Data Loading Wizard (page 4-1)

• "Configuring Globalization Attributes" in Oracle Application Express App
Builder User’s Guide

• "Utilizing Packaged Applications" in Oracle Application Express App Builder
User’s Guide

• "Understanding the Packaged Application Sample Database Application"
in Oracle Application Express App Builder User’s Guide

4.3 Copying and Pasting Data into Your Application
Use the Data Load wizard to copy and paste data from a file, such as a text file.

This procedure includes an example from the sample packaged application, Sample
Database Application.

To upload data to your application, the application must have been built with Data
Upload capability and the pasted data must be formatted properly.

To upload data by copying and pasting:

1. Run the sample packaged application, Sample Database Application.

2. On the Customers page, click Upload Data.

The Data Load wizard appears. Next, select how to upload data.

3. From Import From, select Copy and Paste.

Copying and Pasting Data into Your Application
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4. Under Data Source Load:

a. Copy and Paste Delimited Data - Copy the example comma-separated list
shown in the Data Load Source dialog (First Name,Last Name,Street ...),
and paste it here.

b. Separator - Enter the column separator character. Enter a comma (,) for comma
separators or \t for tab separators.

c. Optionally Enclosed By - Enter a delimiter character. Use this character to
delineate the starting and ending boundary of a data value.

d. First Row has Column Names - Select this option if f your data contains column
names in the first row.

e. Optionally select Use Advanced Settings and configure the following
attributes:

• Decimal Character - Enter a decimal character to separate the integer and
decimal parts of a number. To learn more, see field-level Help.

• Group Separator - Enter a group separator to separate integer groups. Any
non-numeric character can function as the group separator with a few
exceptions. To learn more, see field-level Help.

• Currency Symbol - If your data contains an international currency symbol,
enter it here. See field-level Help for examples.

• File Character Set - Select the file character set associated with the file to be
uploaded.

• Date / Number Formats to use - Select Use application standard format
masks to use the Application Date and Timestamp formats during data
loading or Provide custom formats for uploaded columns to input your
own.
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f. Click Next.

The Data/Table Mapping page appears.

5. For Data/Table Mapping:

a. Target Column - Indicates the destination column name. To change the column
name, select a new column name from the list. To hide a column, select Do Not
Load.

b. Click Next.

The Data Validation page appears showing the data that to be inserted or
updated after any table lookup and transformation rules have been applied.

Copying and Pasting Data into Your Application
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6. For Data Validation, review the data to be uploaded and click Load Data.

The Data Load Results page shows:

• Inserted Row(s) - This is the number of new rows uploaded to the table.

• Updated Row(s) - This is the number of rows in the table updated with new
information.

• Failed Row(s) - This is the number of rows from the upload file that were not
added or updated.

• To be Reviewed Row(s) - This is the number of rows needing review.

7. Click Finish.

See Also:   

• About Using the Data Loading Wizard (page 4-1)

• "Understanding the Packaged Application Sample Database Application"
in Oracle Application Express App Builder User’s Guide

• "Utilizing Packaged Applications" in Oracle Application Express App Builder
User’s Guide

• "Configuring Globalization Attributes" in Oracle Application Express App
Builder User’s Guide

Copying and Pasting Data into Your Application

4-8  Oracle Application Express End User's Guide



5
Using Websheets

User interface elements common to all Websheets include breadcrumb sections,
navigation sections, online help, search, and the Websheet control panel.

About Websheet Applications (page 5-2)
Websheet applications are interactive web pages that combine text with
data. These applications are highly dynamic and defined by their users.

Accessing Websheets (page 5-2)
Users access a Websheet by loading the Websheet URL, logging in with
their account credentials (username and password), and navigating to
the Websheet page.

Using Websheets (page 5-4)
The Websheet application interface contains various elements for quick
navigation and robust text editing.

Managing Websheet Pages (page 5-8)
You can add pages to a Websheet manually or copy existing pages.

Adding and Editing Page Sections (page 5-10)
You can add new sections to a Websheet page with the Create menu and
edit existing sections with the Edit button and Edit menu.

Adding and Editing Text Sections (page 5-12)
You can create a Text section to add text to a Websheet page. You can
type directly into a text section, or copy and paste content from a
spreadsheet.

Adding a Navigation Section (page 5-15)
Add dynamically generated navigation to subordinate pages or page
sections by clicking New Section in the Create menu and create a
Navigation section.

Managing Data Grids (page 5-16)
Data grids are sets of data displayed in rows and columns. Data grids
store data in a similar way to how spreadsheets store data. Once created,
the structure can be modified as needed over time.

Adding and Editing Data Content (page 5-27)
Add content to Websheets that is queried from your Oracle Database
(such as data grids and reports). Note: this function requires your
application’s developer to enable the Allow SQL attribute.

Adding Data Reports (page 5-28)
Data reports are contributor defined queries on tables or views within
the underlying Oracle Database.
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Creating Data Sections Based on a Data Grid or Report (page 5-31)
Add a data grid or data report to a Websheet with data sections.

Creating Chart Sections (page 5-33)
You can create inline charts based upon a data grid or report.

Understanding Markup Syntax (page 5-35)
You can use the following syntax for adding links to Websheet pages,
page sections, external URLs, data grids, or for including SQL or
SQLVALUE syntax.

Managing Annotations (page 5-39)
Add commentary and additional details to a web sheet in annotations.

Managing Websheet Applications (page 5-44)
From a Websheet, you can change your Websheet password, email a
Websheet to another user, and print a Websheet.

Viewing Websheets (page 5-46)
Use the options on the View menu to access presentation mode, view a
page directory, access a page history, and view an application directory.

See Also:   

"Creating Websheet Applications" in Oracle Application Express App Builder
User’s Guide

5.1 About Websheet Applications
Websheet applications are interactive web pages that combine text with data. These
applications are highly dynamic and defined by their users.

Websheet applications include navigation controls, search capabilities, and the ability
to add annotations such as files, notes, and tags. Websheet applications can be secured
using access control lists and several built-in authentication models.

See Also:   

"Using Websheets (page 5-1)"

5.2 Accessing Websheets
Users access a Websheet by loading the Websheet URL, logging in with their account
credentials (username and password), and navigating to the Websheet page.

About Websheet URLs (page 5-3)
Websheet URLs contain an application ID and a page ID. When you
access a Websheet, the session ID also generates in the address bar.

Accessing a Websheet (page 5-3)
To access a Websheet, the Websheet developer provides you a URL and
login credentials (that is, a username and password). Ensure the URL
includes the application ID and page ID, but not the session state ID.

About Websheet Applications

5-2  Oracle Application Express End User's Guide



5.2.1 About Websheet URLs
Websheet URLs contain an application ID and a page ID. When you access a
Websheet, the session ID also generates in the address bar.

Parts of a Websheet URL

The following is an example of a Websheet URL:

http://apex.somewhere.com/pls/apex/ws?p=4350:1:220883407765693447

ws?p=
Indicates that you are accessing an Oracle Application Express Websheet application.

4350
The application ID. Specifies which Websheet application.

1
The page ID. Specifies which page within the application. Depending on how the
developer configured the page, the page ID may be a word, such as home.

220883407765693447
The session ID. The Application Express engine uses the session ID to fetch session
state from the database. Oracle Application Express assigns new session IDs during
authentication processing, records the authenticated user's identity with the session
ID, and continually checks the session ID in each page request's URL or POST data
with the session cookie and the session record in the database.

WARNING:   Do not enter the session state ID when you access a Websheet
URL. Entering information beyond the page ID displays an error.

See Also:   

"About Session IDs" in the Oracle Application Express App Builder User’s Guide

5.2.2 Accessing a Websheet
To access a Websheet, the Websheet developer provides you a URL and login
credentials (that is, a username and password). Ensure the URL includes the
application ID and page ID, but not the session state ID.

To access a Websheet:

1. Click the supplied URL, or enter it in your browser's Address field.

2. Enter your Websheet credentials:

a. Username - Enter your username.

b. Password - Enter your password.

c. Click Log In or Sign In.

Accessing Websheets
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Tip:   

The language that displays differs depending upon who creates the
application. For Oracle-supplied applications, including packaged
applications and the Oracle Application Express development environment,
Sign In or Sign out displays. For applications you or your developers create,
Log In or Log out displays.

The browser navigates to the Websheet.

If you do not have a URL or the URL does not work, contact the person who created
the Websheet.

See Also:   

"Understanding Session State Management" in Oracle Application Express App
Builder User’s Guide

5.3 Using Websheets
The Websheet application interface contains various elements for quick navigation
and robust text editing.

Breadcrumb Sections (page 5-4)
A breadcrumb displays at the top of every Websheet page. Click the
down arrow next to the home breadcrumb to display a submenu of links
to all Websheet pages.

Navigation Sections (page 5-5)
Websheets can contain multiple pages. Each navigation section includes
a hierarchical tree that enables you to navigate between pages or page
sections.

Showing and Hiding Page Sections (page 5-5)
To hide and show a section, click the arrow to the left of a section name.

Online Help (page 5-6)
A Help button displays in the upper right corner of each page. Clicking
Help displays a small Help system that provides an overview of
Websheet functionality.

Signing out of a Websheet (page 5-6)
Click Sign out to log out of a Websheet.

About the Websheet Search Bar (page 5-7)
Perform case insensitive searches of application content in the Search
Websheet search bar.

Control Panel (page 5-7)
For users with developer and administrator rights, the Control Panel
displays on the right side of most Websheet pages.

5.3.1 Breadcrumb Sections
A breadcrumb displays at the top of every Websheet page. Click the down arrow next
to the home breadcrumb to display a submenu of links to all Websheet pages.

To view another page, click the child breadcrumb entry.

Using Websheets
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5.3.2 Navigation Sections
Websheets can contain multiple pages. Each navigation section includes a hierarchical
tree that enables you to navigate between pages or page sections.

Click the arrows on the left to expand or collapse the tree. To open a specific section or
page, click it. Click Expand All to view all pages and page subsections. Click Reset to
return the tree to the default display.

See Also:   Adding a Navigation Section (page 5-15)

5.3.3 Showing and Hiding Page Sections
To hide and show a section, click the arrow to the left of a section name.

Using Websheets
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5.3.4 Online Help
A Help button displays in the upper right corner of each page. Clicking Help displays
a small Help system that provides an overview of Websheet functionality.

Available tabs include: About, Overview, Access Control, Markup Syntax, Data Grid,
Application Content, and FAQ.

See Also:   "About Websheet Applications" in Oracle Application Express App
Builder User’s Guide

5.3.5 Signing out of a Websheet
Click Sign out to log out of a Websheet.

• To exit a running Websheet, click Sign out in the upper right corner.

Tip:   

The language that displays differs depending upon who creates the
application. For Oracle-supplied applications, including packaged
applications and the Oracle Application Express development environment,
Sign In/Sign out displays. For applications you or your developers create,
Log In/Log Out displays.

Using Websheets
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5.3.6 About the Websheet Search Bar
Perform case insensitive searches of application content in the Search Websheet search
bar.

The Search Websheet field displays in the upper right of each Websheet page.

To search a Websheet, click Search Websheet, enter your query, and press Enter.

Search results display in a report. To refresh the view, click the Search button.

Once the search results display, use the Search region on the right side of the page to
control what content to search. Searchable Content options include:

• Page Name

• Page Alias

• Page Description

• Section title

• Section content

• File Name, Alias, Description

• Tags

• Notes

• Data Grid Data

5.3.7 Control Panel
For users with developer and administrator rights, the Control Panel displays on the
right side of most Websheet pages.

You can click the arrow to the right of the region title to hide or display the Control
Panel.

Using Websheets
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The Websheet Control Panel contains the following options:

• New Sections. See "Adding and Editing Page Sections (page 5-10)."

• Edit Sections. See "Adding and Editing Page Sections (page 5-10)."

• New Page. See "Adding a New Page (page 5-8)."

• New Page as a Copy. See "Copying an Existing Page (page 5-9)."

• Edit Page. See "Editing Page Details (page 5-9)."

• Page Directory. See "Viewing the Page Directory (page 5-47)."

• New Data Grid. See "Creating a Data Grid (page 5-17)."

5.4 Managing Websheet Pages
You can add pages to a Websheet manually or copy existing pages.

Tip:   

You can also add a new page by clicking New Page and New Page as a Copy
on the Control Panel.

Adding a New Page (page 5-8)
Add a new page to a Websheet by clicking New Page in the Create
menu.

Copying an Existing Page (page 5-9)
Copy a page in a Websheet by clicking New Page as a Copy in the
Create Menu.

Editing Page Details (page 5-9)
Edit the details of a Websheet page (such as the name, parent page, and
description) by clicking Edit Page in the Edit menu.

5.4.1 Adding a New Page
Add a new page to a Websheet by clicking New Page in the Create menu.

Managing Websheet Pages
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To add a new Websheet page:

1. Run the Websheet application.

2. From the Create menu, select New Page.

3. On Create Page:

a. Name - Enter a page name. The page name displays as the window title and in
the breadcrumb.

b. Page Alias - Identify the page alias. This alias enables you to link to this page.

c. Parent Page - If this page is part of a page hierarchy, then select the parent page.

d. Click Create Page.

See Also:   

• Linking to a Page (page 5-35)

5.4.2 Copying an Existing Page
Copy a page in a Websheet by clicking New Page as a Copy in the Create Menu.

To copy an existing page:

1. Run the Websheet application.

2. From the Create menu, select New Page as a Copy.

3. In New Page Name, enter the name of the new page.

4. Click Copy Page.

A success message appears.

5. Select one of the following:

• View Current Page

• View New Page

Tip:   

You can change the parent page by editing the Page Details. See "Editing Page
Details (page 5-9)."

5.4.3 Editing Page Details
Edit the details of a Websheet page (such as the name, parent page, and description)
by clicking Edit Page in the Edit menu.

On Page Details, you can change the page name, alias, parent page, or page
description.

To edit page details:

Managing Websheet Pages
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1. Run the Websheet application.

2. From the Edit menu, select Edit Page.

3. On the Details Page:

• Name - Identifies the name of the page. The page name displays in the
window title and in the breadcrumb.

• Alias - A page alias enables you to create links in page sections to other pages.
A page alias must be unique within an application.

• Owner - Identifies the owner of the page.

• Parent Page - Identifies the parent page. The defined parent page is used to
construct breadcrumbs and navigation between pages.

• Page Description - Descriptive text that describes the page.

4. Click Apply Changes.

A success message appears.

Tip:   

You can also edit page details by clicking Edit Page on the Control Panel.

See Also:   Linking to a Page (page 5-35)

5.5 Adding and Editing Page Sections
You can add new sections to a Websheet page with the Create menu and edit existing
sections with the Edit button and Edit menu.

About Page Section Types (page 5-10)
Websheets are organized into pages which consist of containers called
sections.

Editing Page Sections (page 5-11)
Edit a section of a Websheet by clicking its Edit button.

Deleting Page Sections (page 5-11)
Delete a section of a Websheet by opening its Edit Section page.

Editing Section Titles and Display Order (page 5-12)
Change the title and display order of a section on the Edit Sections page.

5.5.1 About Page Section Types
Websheets are organized into pages which consist of containers called sections.

To each Websheet page, you can add the following section types:

Text
Display entered text, inline images, inline reports, links to reports, data grids, other
pages, files, external URLs, and so on. You can create and modify text sections using
an intuitive WYSIWIG editor. See "Adding and Editing Text Sections (page 5-12)."

Adding and Editing Page Sections
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Navigation
Add dynamically generated navigation to subordinate pages or page sections. See
"Adding a Navigation Section (page 5-15)."

Data
Create inline reports based upon a data grid or report. See "Creating Data Sections
Based on a Data Grid or Report (page 5-31)" and "Adding Data Reports
(page 5-28)."

Chart
Create inline charts based upon a data grid or report. See "Creating Chart Sections
(page 5-33)."

5.5.2 Editing Page Sections
Edit a section of a Websheet by clicking its Edit button.

To edit a page section:

1. Run the Websheet.

2. Click the Edit icon that displays in the upper right of each section.

The Edit Section page appears.

Tip:   

The left side of the Edit Section page lists all sections on the current page. The
current section is highlighted. To access another section, select it.

3. Edit the section and click Apply Changes.

5.5.3 Deleting Page Sections
Delete a section of a Websheet by opening its Edit Section page.

To delete a page section:

1. Run the Websheet.

Adding and Editing Page Sections
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2. Click the Edit icon that displays in the upper right of the section.

The Edit Section page appears.

3. Click Delete.

5.5.4 Editing Section Titles and Display Order
Change the title and display order of a section on the Edit Sections page.

To edit all sections:

1. Run the Websheet application.

2. From the Edit menu, select Edit Sections.

The Edit Sections page appears.

3. To edit the section title, enter a new title.

4. To change the section order, click the Up and Down arrows adjacent to the section
title.

5. Click Apply Changes.

Tip:   

You can also edit sections by clicking Edit Sections on the Control Panel.

5.6 Adding and Editing Text Sections
You can create a Text section to add text to a Websheet page. You can type directly
into a text section, or copy and paste content from a spreadsheet.

Copying and pasting from a spreadsheet creates a new section for each spreadsheet
row.

Adding a Text Section (page 5-13)
Add a Text section to a Websheet by clicking New Section in the Create
menu.

Adding and Editing Text Sections
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Editing a Text Section (page 5-13)
Edit and format a text section in a Websheet by clicking its Edit icon.

See Also:   

• Deleting Page Sections (page 5-11)

• Understanding Markup Syntax (page 5-35)

5.6.1 Adding a Text Section
Add a Text section to a Websheet by clicking New Section in the Create menu.

To add a text section:

1. Run the Websheet application.

2. From the Create menu, select New Section.

3. When prompted for the section type, select Text and click Next.

4. On Create Text Sections select either:

• Create single text section

• Create multiple text section from Spreadsheet

5. If you select Create single text section, specify the following:

a. Sequence - Enter the section display sequence.

b. Title - Enter a section title.

c. Content - Enter text. To learn more about formatting text, see "Editing a Text
Section (page 5-13)."

d. Click Create Section.

6. If you select Create multiple text section from Spreadsheet, specify the following:

a. First Row Contains Column Headings - Select this option if applicable.

b. Paste Spreadsheet Data - Paste a two column spreadsheet or other tab delimited
data. The first column must contain the section title and the second column
must contain the section content.

c. Click Create Section.

Tip:   

You can also add a new section by selecting New Section on the Control
Panel.

5.6.2 Editing a Text Section
Edit and format a text section in a Websheet by clicking its Edit icon.

To edit a text section:
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1. Run the Websheet application.

2. Click the Edit icon that displays in the upper right of the section.

The Edit Section page appears.

3. Edit the text in the field provided.

4. To change the formatting, click the Expand Toolbar icon in the upper right corner.

The Toolbar appears. When you pass your cursor over an icon, a descriptive tooltip
displays.

5. To hide the toolbar, click the Collapse Toolbar icon.

Adding and Editing Text Sections
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6. To save your changes, click Apply Changes.

See Also:   Understanding Markup Syntax (page 5-35)

5.7 Adding a Navigation Section
Add dynamically generated navigation to subordinate pages or page sections by
clicking New Section in the Create menu and create a Navigation section.

To add a navigation section:

1. Run the Websheet application.

2. From the Create menu, select New Section.

3. When prompted for the section type, select Navigation and click Next.

4. For Navigation Type:

a. Select either:

• Page Navigation - Creates navigation of all pages in the Websheet.

• Section Navigation - Creates navigation for all sections on a page.

b. Click Next.

5. If you select Page Navigation, specify the following:

a. Sequence - Enter the section display sequence.

Adding a Navigation Section
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b. Title - Enter a section title.

c. Starting Page - Select the starting page from which to display hierarchical
navigation.

d. Maximum Levels - Select the maximum number of levels (or tree depth) to
display.

e. Order Siblings By - Select the order of siblings by column. If not defined, then
the siblings are sorted by the page name.

f. Click Create Section.

6. If you select Section Navigation, specify the following:

a. Sequence - Enter the section display sequence.

b. Title - Enter a section title.

c. Click Create Section.

See Also:   

• Deleting Page Sections (page 5-11)

• Editing Section Titles and Display Order (page 5-12)

5.8 Managing Data Grids
Data grids are sets of data displayed in rows and columns. Data grids store data in a
similar way to how spreadsheets store data. Once created, the structure can be
modified as needed over time.

About Data Grids (page 5-17)
You can define the structure of a data grid using column names, data
sources, and basic validations, or you can create a data grid by pasting
spreadsheet data. Once created, the structure can be modified as needed.

Creating a Data Grid (page 5-17)
You can create a data grid by either defining the structure (that is, the
column names, data sources, and basic validations), or by pasting in
spreadsheet data.

Copying a Data Grid (page 5-19)
Copy a data grid by clicking Copy in the Manage menu.

Viewing and Editing a Data Grid (page 5-19)
Once you create a data grid, you can view and edit it on the Data page.

Viewing the Data Grid Change History Log (page 5-27)
View the change history log of a data grid by selecting History in the
Manage menu.

Deleting a Data Grid (page 5-27)
Delete a data grid by selecting Delete Data Grid in its Manage menu.

Managing Data Grids
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See Also:   

• Adding and Editing Data Content (page 5-27)

• Understanding Markup Syntax (page 5-35)

5.8.1 About Data Grids
You can define the structure of a data grid using column names, data sources, and
basic validations, or you can create a data grid by pasting spreadsheet data. Once
created, the structure can be modified as needed.

You can alter the layout of report data by selecting columns or by applying filters,
highlighting, and sorting. You can also define breaks, aggregations, group bys,
computations, and different charts.

Additionally, you can create multiple variations of a data grid and save them as
named reports, for either public or private viewing. You can also use the data from a
data grid and include it as a chart or report within any page.

See Also:   

Creating Chart Sections (page 5-33)

5.8.2 Creating a Data Grid
You can create a data grid by either defining the structure (that is, the column names,
data sources, and basic validations), or by pasting in spreadsheet data.

In addition to the defined columns, the following standard columns are always
included within each data grid: owner, created by, created on, updated by, updated
on, row order, and annotation (files, notes, links, and tags).

Creating a Data Grid from Scratch (page 5-17)
Create a data grid from scratch by clicking New Data Grid in the Create
menu and selecting From Scratch.

Creating a Data Grid by Copying and Pasting Spreadsheet Data (page 5-18)
Create a data grid by copying and pasting spreadsheet data by clicking
New Data Grid in the Create menu and selecting Copy and Paste.

5.8.2.1 Creating a Data Grid from Scratch
Create a data grid from scratch by clicking New Data Grid in the Create menu and
selecting From Scratch.

When you create a data grid from scratch you must define the column names,
datatypes, and basic values. Once you have created the basic structure, you can then
populate it with data.

To create a data grid from scratch:

1. Run the Websheet application.

2. From the Create menu, select New Data Grid.

Managing Data Grids
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Tip:   

You can also select New Data Grid on the Control Panel.

3. When prompted for the section type, select From Scratch and click Next.

4. Specify the following:

a. Name - Enter a data grid name.

b. Alias - Enter a data grid alias. Use this alias to link to this data grid within other
page sections. A data grid alias must be unique within an application.

c. Define the data grid structure by specifying the column name and data type. To
change the order, click the Up and Down arrow under Move.

Note:   To add more columns, click Add Column.

d. Click Create Data Grid.

The data grid appears.

5. To add data, click Add Row.

See Also:   Editing Data Grid Data (page 5-21)

5.8.2.2 Creating a Data Grid by Copying and Pasting Spreadsheet Data
Create a data grid by copying and pasting spreadsheet data by clicking New Data
Grid in the Create menu and selecting Copy and Paste.

To create a data grid by copying and pasting spreadsheet data:

1. Run the Websheet application.

2. From the Create menu, select New Data Grid.

Tip:   

You can also select New Data Grid from the Create menu or the Control
Panel.

3. When prompted for the section type, select Copy and Paste and click Next.

4. Specify the following:

a. Name - Enter a data grid name.

b. Alias - Enter a data grid alias. You can use this alias to link to this data grid
within page sections. A data grid alias must be unique within an application.

c. First Row Contains Column Headings - Select this option if applicable.

d. Paste Spreadsheet Data - Copy and paste the data you want to load from a
spreadsheet program.

e. Click Upload.

A data grid appears.
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5.8.3 Copying a Data Grid
Copy a data grid by clicking Copy in the Manage menu.

To copy a data grid:

1. Run the Websheet application.

2. From the Data Grid menu, select an existing data grid.

The data grid appears.

3. From the Manage menu, select Copy.

4. Enter a new data grid name and click Copy.

5.8.4 Viewing and Editing a Data Grid
Once you create a data grid, you can view and edit it on the Data page.

Tip:   

Data grids display as an interactive report.

Accessing the Data Page (page 5-20)
Access the Data page by selecting View All in the Data Grid menu.

Toggling Check Boxes (page 5-21)
Toggle whether check boxes display when viewing a data grid by
selecting Toggle Checkboxes in the Manage menu.

Editing Data Grid Data (page 5-21)
Edit the data in a data grid by clicking a valid cell or add a new row by
clicking the Add Row button.

Editing Data Grid Columns Manually (page 5-22)
Manually edit columns in a data grid by clicking Columns in the
Manage menu.

Editing Data Grid Rows Manually (page 5-23)
Manually edit rows in a data grid by clicking Rows in the Manage menu.

Editing a Single Data Grid Row (page 5-23)
Edit a single row in a data grid by clicking its Edit Row icon (pencil).

Adding Annotations to a Single Data Grid Row (page 5-24)
Add annotations to a row in a data grid by clicking its Edit Row icon
(pencil).

Displaying Annotation Columns in a Data Grid Report (page 5-25)
Choose which columns to display in a data grid by clicking the Actions
menu and selecting Select Columns.

Displaying Pseudo Columns in a Data Grid Report (page 5-25)
Choose whether to display pseudo columns in a data grid report by
clicking the Actions menu and selecting Select Columns, then save the
report.
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Editing Data Grid Properties (page 5-26)
Change the name, alias, and description of a data grid on the Data Grid
Properties page.

Creating a Bookmark Link to a Data Grid (page 5-26)
Create a bookmark link to a data grid by adding the appropriate syntax
to the URL of its parent Websheet or retrieving the URL manually.

See Also:   

• Using Interactive Reports (page 3-1)

• Customizing an Interactive Report Using the Actions Menu (page 3-6)

5.8.4.1 Accessing the Data Page
Access the Data page by selecting View All in the Data Grid menu.

To access the Data page:

1. Run the Websheet application.

2. From the Data Grid menu, select View All.

An interactive report appears displaying all data grids. The report also appears in
the Report view.

Tip:   

If icons display, then click the View Report icon.

By default, the Report view displays the data grid Name, Alias, Updated, and
Updated By columns. The Embed Tag column displays the syntax used to include a
link to the report or data grid from within a section of a page.

3. Select a data grid.

The data grid appears.
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5.8.4.2 Toggling Check Boxes
Toggle whether check boxes display when viewing a data grid by selecting Toggle
Checkboxes in the Manage menu.

Use the checkboxes for custom selections.

• To display checkboxes adjacent to each row:

• Click the Manage menu and select Toggle Checkboxes.

When enabled, check boxes display to the left of each row.

5.8.4.3 Editing Data Grid Data
Edit the data in a data grid by clicking a valid cell or add a new row by clicking the
Add Row button.

To edit data grid data:

1. Run the Websheet application.

2. From the Data Grid menu, select a data grid.

The data grid appears.
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3. Click a valid cell.

The cell expands into an editable text field.

4. When finished, click outside of the cell or press the Tab key to proceed to the next
cell in the column.

Changes are saved automatically.

To add another row:

5. Click the Add Row button.

A form appears.

6. Edit the fields provided. Each field is a column within the new row.

7. Click either Save or Save and Add Another.

Tip:   You can also edit an entire row by clicking the Edit Row button (pencil)
adjacent to the row.

5.8.4.4 Editing Data Grid Columns Manually
Manually edit columns in a data grid by clicking Columns in the Manage menu.

To manually edit data grid columns:

1. Run the Websheet application.

2. From the Data Grid menu, select a data grid.

The data grid appears.

3. From the Manage menu, select Columns.

The following submenu displays:

Add
Adds a new column. Enables you to define all column properties such as the
column name, group, type, value required, display as, list of values, default type,
and so on.

Column Properties
Editable properties include sequence, group, required value, display as, label,
format, heading alignment, column alignment, default text, help text, and so on.

List of Values
Enables you to restrict the values a user can enter. You associate a list of values
with a column on Column Properties.

Column Groups
Create a group and add columns to the group. Enables you to define the group
name and provide a description. You can select the columns for the new column
group in the Column region by using the arrow keys.

Validation
Enables you to define a column validation, sequence, validation expression, and
error message.
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Delete Columns
Select columns to delete.

4. Select a submenu option and follow the on-screen instructions.

5.8.4.5 Editing Data Grid Rows Manually
Manually edit rows in a data grid by clicking Rows in the Manage menu.

To manually edit data grid rows:

1. Run the Websheet application.

2. From the Data Grid menu, select a data grid.

The data grid appears.

3. From the Manage Menu, select Rows.

The following submenu displays:

Add Row

Adds a new row. Enables you to define the project, task, start date, end date, and
so on.

Tip:   

You can also click the Add Row button in the data grid to add a new row.

Set Column Values
Set a predefined value for a column for all rows, selected rows, or empty rows.

Replace
Search and replace row values for all rows or selected rows.

Fill
Fill NULL column values with a column value from the above cell. Select a column
from which you want to fill the NULL column value.

Delete Rows
Select to delete all rows, selected rows, or rows with empty columns.

4. Select a submenu option and follow the on-screen instructions.

5.8.4.6 Editing a Single Data Grid Row
Edit a single row in a data grid by clicking its Edit Row icon (pencil).

To manually edit a single data grid row:

1. Run the Websheet application.

2. From the Data Grid menu, select a data grid.

The data grid appears.

3. Locate the row to be edited and click the Edit Row icon.

The Add/Edit Row page appears.
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4. Edit the appropriate rows and click Apply Changes.

Tip:   

You can use the Actions region on the Add/Edit Row page to add a new row,
add a file, add annotations, add links, add tags, view a history of changes, add
a column, edit column properties and group, delete columns, and create a list
of values or a validation.

5.8.4.7 Adding Annotations to a Single Data Grid Row
Add annotations to a row in a data grid by clicking its Edit Row icon (pencil).

To add annotations (that is, files, notes, links, and tags) to a single data grid row:

1. Run the Websheet application.

2. From the Data Grid menu, select a data grid.

The data grid appears.

3. Locate the row to be edited and click the Edit Row icon.

The Add/Edit Row page appears.

4. From the Actions region, select one of the following:

• Add File

• Add Note

• Add Link

• Add Tags

5. Follow the on-screen instructions.

See Also:   

Managing Annotations (page 5-39)
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5.8.4.8 Displaying Annotation Columns in a Data Grid Report
Choose which columns to display in a data grid by clicking the Actions menu and
selecting Select Columns.

To display annotation columns (such as Files, Notes, Links, and Tags) in a data grid
report:

1. View the data grid report.

2. Click the Actions menu and then Select Columns.

3. In the Select Columns region, move the columns (for example, Files, Notes, Links,
and Tags) to Display in Report.

4. Click Apply.

To ensure that all users can see the columns, developers can save the revised layout as
the default report.

To save a new default report:

5. Click the Actions menu and select Save Report.

The Save Report Region appears.

6. In Save Report:

a. Save - Select As Default Report Settings.

b. Name - Enter a name for the report.

c. Description - Enter an optional description.

d. Click Apply.

5.8.4.9 Displaying Pseudo Columns in a Data Grid Report
Choose whether to display pseudo columns in a data grid report by clicking the
Actions menu and selecting Select Columns, then save the report.

Data grids include the following pseudo columns:

Owner
The username who created the row.

Row Key
The user-friendly alphanumeric unique key to identify a row.

Row Order
The unique number to identify a row.

Created By
The username who created the row.

Created On
The date when the row was created.

To display pseudo columns in a data grid report:
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1. Include the pseudo columns in the data grid report:

a. View the data grid report.

b. Click the Actions menu and then Select Columns.

c. In the Select Columns region, move the pseudo columns to Display in Report.

d. Click Apply.

2. Save a new default report:

a. Click the Actions menu and select Save Report.

The Save Report Region appears.

b. In Save Report:

i. Save - Select As Default Report Settings.

ii. Name - Enter a name for the report.

iii. Description - Enter an optional description.

iv. Click Apply.

5.8.4.10 Editing Data Grid Properties
Change the name, alias, and description of a data grid on the Data Grid Properties
page.

To edit data grid properties:

1. Run the Websheet application.

2. From the Data Grid menu, select a data grid.

The data grid appears.

3. From the Manage menu, click Properties.

The Data Grid Properties page appears.

4. Edit the fields provided and click Apply.

5.8.4.11 Creating a Bookmark Link to a Data Grid
Create a bookmark link to a data grid by adding the appropriate syntax to the URL of
its parent Websheet or retrieving the URL manually.

To bookmark directly to a data grid or a row:

1. Use the following syntax:

ws?p=100000:DG_<data grid alias> 
ws?p=100000:DG_<data grid alias>::ROW_ID:<data grid row ID>

The data grid row ID is an ID column value of the APEX$_WS_ROWS table.

To get a link to a specific data grid row:
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2. Run the data grid.

3. Click the Edit Row icon.

4. Note the URL in the browser.

5.8.5 Viewing the Data Grid Change History Log
View the change history log of a data grid by selecting History in the Manage menu.

The View Change History log displays a report of data grid changes. This report lists
the row, column name, old value, new value, user who authored the change, and how
long ago the change occurred.

To view a history of data grid changes:

1. Run the Websheet application.

2. From the Data Grid menu, select a data grid.

The data grid appears.

3. From the Manage menu, select History.

5.8.6 Deleting a Data Grid
Delete a data grid by selecting Delete Data Grid in its Manage menu.

To delete a data grid:

1. Run the Websheet application.

2. From the Data Grid menu, select a data grid.

The data grid appears.

3. From the Manage menu, select Delete Data Grid.

4. Confirm your selection and click Delete.

5.9 Adding and Editing Data Content
Add content to Websheets that is queried from your Oracle Database (such as data
grids and reports). Note: this function requires your application’s developer to enable
the Allow SQL attribute.

About Available Data Sources (page 5-28)
You can include other Oracle Application Express data sources in
Websheets. Once defined, you can incorporate these data sources into
Websheet page sections.

Enabling Support for Creating Data Reports (page 5-28)
To define a data report, your Websheet developer must enable the Allow
SQL attribute on the Application Properties page.

About Incorporating Data into Websheet Pages (page 5-28)
Data grids and data reports can be incorporated into page sections in the
following ways.
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5.9.1 About Available Data Sources
You can include other Oracle Application Express data sources in Websheets. Once
defined, you can incorporate these data sources into Websheet page sections.

Websheets can include the following data sources:

Data Grids
Data grids are highly customizable, editable tabular reports. Data grids enable you to
maintain data within the Websheet that is stored within the Oracle Database. See
"Managing Data Grids (page 5-16)."

Reports
Reports are queries defined against tables or views that exist within your Oracle
Database. See "Adding Data Reports (page 5-28)."

5.9.2 Enabling Support for Creating Data Reports
To define a data report, your Websheet developer must enable the Allow SQL
attribute on the Application Properties page.

By default, this attribute is disabled.

• To enable support for creating data reports:

• Contact your developer.

Only a Websheet application developer can edit the Allow SQL attribute on the
Application Properties page.

See Also:   "Understanding Websheet Properties" in Oracle Application Express
App Builder User’s Guide.

5.9.3 About Incorporating Data into Websheet Pages
Data grids and data reports can be incorporated into page sections in the following
ways.

Within a Data Section
See "Adding Data Reports (page 5-28)."

Within a Chart Section
See "Adding a Chart Section (page 5-33)."

Linking to a Data Grid
See "Linking to a Data Grid (page 5-36)."

Include a single value or tabular results of queries
See "Using SQL and SQLVALUE Syntax (page 5-37)."

5.10 Adding Data Reports
Data reports are contributor defined queries on tables or views within the underlying
Oracle Database.
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Important:   

Before you can add a data report, your Websheet application developer must
enable the Allow SQL attribute on the Websheet properties page. By default,
this attribute is disabled.

About Data Reports (page 5-29)
Data reports, unlike data grids, are query-only and based on existing
data from the Oracle Database. You can specify the table or view name
and retrieve all columns or write a SQL statement to retrieve the
required data.

Creating a Data Report (page 5-30)
Create a data report either by entering the table or view name or by
providing a SQL query.

Viewing and Modifying a Data Report (page 5-30)
View a data report by selecting View All in the Report menu, then edit
the report by clicking Edit Attributes.

Deleting a Data Report (page 5-31)
Delete a data report from a Websheet by clicking Delete in the Report
Attributes page.

See Also:   

• Adding and Editing Data Content (page 5-27)

• Understanding Markup Syntax (page 5-35)

• "Editing Websheet Application Properties" in Oracle Application Express
App Builder User’s Guide

5.10.1 About Data Reports
Data reports, unlike data grids, are query-only and based on existing data from the
Oracle Database. You can specify the table or view name and retrieve all columns or
write a SQL statement to retrieve the required data.

You can alter the layout of report data by selecting columns or by applying filters,
highlighting, and sorting. You can also define breaks, aggregations, group by,
computations, and different charts.

Additionally, you can create multiple variations of a data grid and save them as
named reports, for either public or private viewing. You can also use the data from a
data report and include it as a chart or report within any page.

See Also:   

• Creating Data Sections Based on a Data Grid or Report (page 5-31)

• Creating Chart Sections (page 5-33)
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5.10.2 Creating a Data Report
Create a data report either by entering the table or view name or by providing a SQL
query.

To create a data report:

1. Run the Websheet application.

2. From the Report menu, select New Report.

Tip:   

You can also select New Report on the Control Panel.

The Create Report page appears.

3. For Report Source, identify how to develop your source. Options include:

• Table - Select Table and enter the following:

– Table or View Name - Select the name of the table or view on which to
base the report.

– Report Name - Enter the name of the report.

– Report Alias - Enter a report alias. A Report alias is used for linking to the
Report within page sections. A Report alias must be unique within an
application.

• SQL Query - Select SQL Query and enter the following:

– Report Name - Enter the name of the report.

– Report Alias - Enter a report alias. A Report alias is used for linking to the
Report within page sections. A Report alias must be unique within a
Websheet.

– Query - Enter the SQL query that defines your report.

4. Click Next.

5. Confirm your selections and click Create Report.

5.10.3 Viewing and Modifying a Data Report
View a data report by selecting View All in the Report menu, then edit the report by
clicking Edit Attributes.

To view or modify a data report:

1. Run the Websheet application.

2. From the Report menu, select View All.

The Report page appears.

3. Select the report.

The report appears.
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4. To edit report attributes:

a. From the Manage menu, click Edit Attributes.

The Report Attributes page appears.

b. Edit the attributes and click Apply Changes.

5. To edit the report query:

a. From the Manage menu, click Edit Query.

The Report Query page appears.

b. Edit the report query and click Apply Changes to save your query.

5.10.4 Deleting a Data Report
Delete a data report from a Websheet by clicking Delete in the Report Attributes page.

To delete a data report:

1. Run the Websheet application.

2. From the Report menu, select the report.

The report appears.

3. Select the report.

The report appears.

4. From the Manage menu, click Edit Attributes.

The Report Attributes page appears.

5. Click Delete.

5.11 Creating Data Sections Based on a Data Grid or Report
Add a data grid or data report to a Websheet with data sections.

Adding a Data Section to a Page (page 5-31)
Add a data section to a page by selecting Data in the New Section
wizard, then specify how to import the desired data grid or report.

Editing a Data Section (page 5-32)
Edit a data section by clicking its adjacent Edit icon.

See Also:   

Adding and Editing Data Content (page 5-27)

5.11.1 Adding a Data Section to a Page
Add a data section to a page by selecting Data in the New Section wizard, then specify
how to import the desired data grid or report.
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If you do not have a saved report with the settings you need, create it now before
adding the section.

Once you create a data grid or report, you add it to a page by adding a data section.

To add a data section:

1. Run the Websheet application.

2. From the Create menu, select New Section.

3. When prompted for the section type, select Data and click Next.

4. Specify the following:

a. Data Section Source - Select either Data Grid or Report.

b. Display Sequence - Enter the section display sequence.

c. Data Grid/Report - Select the data grid or report to be used to display the data
section.

d. Report Settings to Use - For the selected data grid or report, select the report
settings to use. This selection enables you to filter the rows and columns you
want to display and set the columns to display.

e. Title - Enter the section title.

f. Maximum Row Count - Enter a value to define the maximum number of rows
to query.

g. Include - Select whether to add the following:

• Add Row (available if Data Section Source is data grid)

• Edit Row (available if Data Section Source is data grid)

• Search Field

h. Style - Choose a user interface style.

5. Click Next.

6. Click Create Section.

See Also:   

• Managing Data Grids (page 5-16)

• Adding Data Reports (page 5-28)

5.11.2 Editing a Data Section
Edit a data section by clicking its adjacent Edit icon.

Once you have added a data report to a page, you can change the section sequence,
title, and user interface style.
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To edit a data section:

1. Run the Websheet application.

2. Click the Edit icon that displays in the upper right of the section.

The Edit Section page appears.

3. Edit the fields provided. See item Help for more details.

4. To save your changes, click Apply Changes.

5.12 Creating Chart Sections
You can create inline charts based upon a data grid or report.

Adding a Chart Section (page 5-33)
Add a chart section to a Websheet by clicking New Section in the Create
menu and selecting Chart.

Editing a Chart Section (page 5-34)
Edit a chart section in a Websheet by clicking its adjacent Edit icon.

See Also:   

Adding and Editing Data Content (page 5-27)

5.12.1 Adding a Chart Section
Add a chart section to a Websheet by clicking New Section in the Create menu and
selecting Chart.

To add a chart section:

1. Run the Websheet application.

2. Create a data grid or report.

3. From the Create menu, select New Section.

4. When prompted for the section type, select Chart and click Next.

5. On Select Chart Type:

a. Select one of the following:

• Column

• Horizontal Bar

• Pie

• Line

b. Click Next.

6. Specify the following:

a. Chart Source - Select either Data Grid or Report.
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b. Display Sequence - Enter the section display sequence.

c. Data Grid/Report - Select the data grid or report to be used to display the chart.

d. Report Settings to Use - For the selected data grid or report, select the report
settings to use. Use this option to filter the rows and columns you want to
display.

If you do not have a saved report with the settings you need, then create it now
before adding the section.

e. Section Title - Enter the section title.

f. Click Next.

7. Specify the following:

a. Chart Label - Select the column to be used as the Label.

In Axis Title for Label, enter the title to display on the axis associated with the
column selected for Label.

b. Chart Value - Select the column to be used as the Value. If your function is a
COUNT, a Value does not need to be selected.

In Axis Title for Value, enter the title to display on the axis associated with the
column selected for Value.

c. Function - Select a function to be performed on the column selected for Value.

d. Sort - Select the chart sort direction.

Check Enable 3D to display the chart in 3D.

e. Click Next.

8. On the summary page, confirm your selections and click Create Section.

See Also:   

• Managing Data Grids (page 5-16)

• Adding Data Reports (page 5-28)

5.12.2 Editing a Chart Section
Edit a chart section in a Websheet by clicking its adjacent Edit icon.

To edit a chart section:

1. Run the Websheet application.

2. Click the Edit icon that displays in the upper right of the section.

The Edit Section page appears.

3. Edit the fields provided. See item Help for more details.

4. Click Apply Changes.
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5.13 Understanding Markup Syntax
You can use the following syntax for adding links to Websheet pages, page sections,
external URLs, data grids, or for including SQL or SQLVALUE syntax.

Tip:   

A Help button displays in the upper right corner of each Websheet page. The
Help page, Markup Syntax, lists all the different syntax options described in
this section.

Linking to a Page (page 5-35)
You can include links in page sections to other pages in a Websheet by
using the following syntax.

Linking to a Section (page 5-36)
You can include links to a page section by using the following syntax.

Linking to External URLs (page 5-36)
You can include links to external URLs in page sections by using the
following syntax.

Linking to a Data Grid (page 5-36)
You can include links to data grids within page sections by using the
following syntax.

Using SQL and SQLVALUE Syntax (page 5-37)
You can include single value and tabular results of queries against data
grids or tables and views within sections of a page by using SQL or
SQLVALUE syntax.

Advanced Data Grid Queries Rules (page 5-38)

See Also:   

Managing Uploaded Files and Images (page 5-39)

5.13.1 Linking to a Page
You can include links in page sections to other pages in a Websheet by using the
following syntax.

If the page exists, a link displays. If the page does not exist, a link to create the page
displays. Note that the use of the page: identifier is optional.

Syntax:

[[ page: <page alias> | <link name> ]]
[[ <page alias> | <link name> ]]

Syntax Example:

[[page: home]] 
[[mypage | My Page]]
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In Context Example:

One of the most colorful fish is the [[ clownfish | Clown fish]].

5.13.2 Linking to a Section
You can include links to a page section by using the following syntax.

If the section exists, a link displays. If the section does not exist, a link to create the
section displays. Note that if the section is not prefaced by a page, it is assumed the
section is on the current page.

Syntax:

[[ section: <page alias> . <page section> | <link name> ]]
[[ section: <page section> | <link name> ]]

Syntax Example Linking Within the Current Page:

[[section: clownfish | Clown Fish]] 

Syntax Example Linking to a Different Page:

[[section: fish.clownfish | Clown Fish]] 

In Context Example:

One of the most colorful fish is the [[ section: clownfish | Clown fish]].
Visit or fish page to see the [[ section: fish . clownfish | Clown fish]], also 
known as Nemo.

5.13.3 Linking to External URLs
You can include links to external URLs in page sections by using the following syntax.

Note that the use of the url: identifier is optional. To have the link open in a new
browser window, use the popup prefix.

Syntax:

[[ url: <url> | <link name> ]]
[ popupurl: <url> | <link name> ]]
[[ <url> | <link name> ]]

Syntax Example:

[[url: http://www.company.com/store | commpanystore]]
[[popupurl: http://www.company.com/store | commpanystore]]
[[http://www.searchengine.com | searchengine]] 
[[http://www.searchengine.com ]] 

In Context Example:

You can buy Company software on the [[http://www.company.com/store | Company Store]] 
website.

5.13.4 Linking to a Data Grid
You can include links to data grids within page sections by using the following syntax.
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You can use these links to view the data grid or to create new data.

Tip:   

Note that data grid can be one or two words.

Syntax:

[[ data grid: <datagrid alias | <link name> ]]
[[ datagrid: <datagrid alias | <link name> ]]
[[ datagrid: <datagrid alias . <saved report name (may not be private)> | <link 
name> ]] 

Syntax Example:

[[ data grid: todo list | To Do List ]]
[[ data grid: todo list . open todo items | To Do List ]]
[[ datagrid: todo list | To Do List ]] 

In Context Example:

Please review the [[ data grid: todo list | To Do List ]] and ensure your tasks can 
be accomplished by Friday.

5.13.5 Using SQL and SQLVALUE Syntax
You can include single value and tabular results of queries against data grids or tables
and views within sections of a page by using SQL or SQLVALUE syntax.

The SQLVALUE tag displays the first column of the first row returned by the SQL
query. Use this syntax to embed data within a sentence (for example: There are
currently 5 types of cats.). For tabular results, use the SQL tag. Using SQL tag produces
a searchable report. However, you can disable the search option by using the
NOSEARCH syntax.

When working with data grids, there are a few more options (shown under Syntax)
and a few more rules. Basic rules when writing a data grid query include:

• Enclose the data grid name or data grid alias with braces. For example:

{Cat Facts}

• Enclose the data grid column names with double quotation marks. For example:

"Type of Cat"

See Also:   

Advanced Data Grid Queries Rules (page 5-38)

Syntax for Queries Against Tables and Views:

[[sql: <select statement> ]]
[[sql: <select statement | limit="<maximum rows>" nosearch style="<style number>" ]]
[[sqlvalue: <select statement> ]]
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Syntax for Data Grid Queries:

[[sql: <select statement> ]]
[[sql: <select statement | limit="<maximum rows>" nosearch style="<style number>" 
edit_row add_row show_sql ]]
[[sqlvalue: <select statement> ]]
[[sqlvalue: <select statement> | show_sql ]]

In Context SQL Tag Syntax Examples:

[[sql: select ename "Employee Name", sal "Salary" from emp order by sal desc | 
limit="10" style="2"]].
[[sql: select "Type of Cat",
              "Estimated Population",
              "Largest Threats",
              "Top Speed",
              "Scientific Name",
              "IUCN Status",
              "Weight",
              "Study Date"
       from {Cat Facts} | add_row edit_row ]]

In Context SQLVALUE Tag Syntax Examples:

We have [[sqlvalue: select count(*) from emp]] employees in our database, 
[[sqlvalue: select count(*) from emp where deptno=10 ]] work in department 10.
We are currently tracking [[sqlvalue: select count(*) from {Cat Facts} ]] 
types of cats.

5.13.6 Advanced Data Grid Queries Rules
Advanced data grid query rules include:

• The query must reference the data grid only once to include an edit or add row
link (that is, you cannot join the data grid to itself within the query).

• The first column must be the primary key of the data grid to include an edit row
link (that is, the column that uniquely identifies the row of data). If the "edit_row"
option is included and the query has a single select statement, the primary key
column is included automatically. If the query contains multiple select statements,
you can use the "APXWS_DATA_GRID_PK" substitution (always enclosed with
double quotation marks) as the first column in the SELECT statement to include
the primary key to include an edit row link.

• Report column names are the column name from the data grid, but can be
modified using standard SQL column aliasing syntax. For example, the following
displays the data from the Minimum Number column but the heading displays as
Min:

select "Minimum Number" "Min" from ...

• If a column name is longer than 30 characters, you only include the first 30
characters as the name. For example, use:

"% of Estimated Lions per Regio"

Instead of:

"% of Estimated Lions per Region"
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• To display the query that is executed, include the "show_sql" option. By
including this option, the query displays above the included report. Although this
is a good approach for debugging, Oracle does not recommend "show_sql" for a
production application.

5.14 Managing Annotations
Add commentary and additional details to a web sheet in annotations.

Annotations can be in the form of uploaded files, notes, links, and tags. Annotations
can be added to both pages and data grid records.

Managing Uploaded Files and Images (page 5-39)
You can upload files and images to a Websheet page using the Files
region. Once uploaded, you can display uploaded images within a page
section or embed download links to files.

Adding Tags (page 5-41)
You can add tags to facilitate keyword searching within a Websheet.

Adding Notes (page 5-42)
Use notes to record user comments. You can add, edit, and delete notes.

Viewing and Deleting Annotations (page 5-43)
Annotations include uploaded files, notes, links, and tags that were
either added to a Websheet page or to a specific row in a data grid. You
can view and delete all Websheet annotations on the Annotations page.

See Also:   

Adding Annotations to a Single Data Grid Row (page 5-24)

5.14.1 Managing Uploaded Files and Images
You can upload files and images to a Websheet page using the Files region. Once
uploaded, you can display uploaded images within a page section or embed
download links to files.

Uploading Files and Images (page 5-40)
Upload a file or image to a Websheet by clicking the Add File icon (+) in
the Files menu.

Including a Download Link in a Page Section (page 5-40)
You can embed a download link within a page section to uploaded files
using the following syntax.

Displaying an Uploaded Image Inline (page 5-41)
After you upload an image, you can display it within any page section of
an application by embedding a download link using the following
syntax. Reference an uploaded image using the image name or image
alias.

Editing or Deleting Uploaded Files (page 5-41)
Edit or delete an uploaded file by clicking the Edit File icon in the Files
region.
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5.14.1.1 Uploading Files and Images
Upload a file or image to a Websheet by clicking the Add File icon (+) in the Files
menu.

To upload files and images to a Websheet:

1. Log in to and run the Websheet.

2. Under Files on the right side of the page, click the Add File icon.

3. On the Add File page:

a. File - Browse to locate the file to upload. Once uploaded, the file is associated
with the current page. You can reference an uploaded file in any page using the
image or file syntax.

b. Alias - A file alias enables you to embed download links or image links within
page sections. A file alias must be unique within an application.

c. Description - Enter descriptive text to describe the file.

4. Click Add File.

See Also:   Displaying an Uploaded Image Inline (page 5-41)

5.14.1.2 Including a Download Link in a Page Section
You can embed a download link within a page section to uploaded files using the
following syntax.

Syntax:

[[ file: < file name > | < link name > ]]
[[ file: < file alias > | < link name > ]]

Syntax Examples:

[[file: myfile ]]
[[file: myfile.xls ]]
[[file: myfile | My File ]]

File Markup Example:

This [[file: parts01.xls | spreadsheet ]] documents our part numbers.
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5.14.1.3 Displaying an Uploaded Image Inline
After you upload an image, you can display it within any page section of an
application by embedding a download link using the following syntax. Reference an
uploaded image using the image name or image alias.

Images defined for the current page are used before images associated with other
pages. If image names are ambiguous, the most recently created image displays.

Syntax:

[[ image: < file name > | < properties > ]]
[[ image: < file alias > | < properties > ]]

Syntax Examples:

[[image: myimage ]]
[[image: theimagename.jpg ]]
[[image: myimage | width="600" alt="my image" ]]

Example:

This diagram [[image: diagram1]] illustrates the work flow.

5.14.1.4 Editing or Deleting Uploaded Files
Edit or delete an uploaded file by clicking the Edit File icon in the Files region.

To edit details or delete uploaded files:

1. Log in to and run the Websheet.

2. In the Files region, click theEdit File icon.

The Details page appears.

3. To edit file details:

a. Edit the fields provided. See item Help for more details.

b. To accept your changes, click Apply Changes.

4. To delete a file:

a. Click Delete.

b. To accept your changes, click OK.

5.14.2 Adding Tags
You can add tags to facilitate keyword searching within a Websheet.

Adding Tags (page 5-42)
Add tags to a Websheet page by clicking the Add tag icon (+) in the Tags
region.

Editing Existing Tags (page 5-42)
Edit an existing tag by clicking its Edit Tag icon.
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Deleting Existing Tags (page 5-42)
Delete a tag by clicking the View Tag icon in the Tags region then
selecting it for deletion.

5.14.2.1 Adding Tags
Add tags to a Websheet page by clicking the Add tag icon (+) in the Tags region.

To add tags to a Websheet page:

1. Log in to and run the Websheet.

2. Under Tags on the right side of the page, click the Add Tag icon.

3. Enter tags in the field provided. Separate multiple tags with a comma.

4. Click Apply Changes.

5.14.2.2 Editing Existing Tags
Edit an existing tag by clicking its Edit Tag icon.

To edit existing tags:

1. Log in to and run the Websheet.

2. In the Tags region, click the Edit Tag icon.

The Details page appears.

3. Edit the tags and click Apply Changes.

5.14.2.3 Deleting Existing Tags
Delete a tag by clicking the View Tag icon in the Tags region then selecting it for
deletion.

To delete existing tags:

1. Log in to and run the Websheet.

2. In the Tags region, click the View Tag icon.

The Tags page appears.

3. Select the tags that you want to delete and click Delete Checked.

5.14.3 Adding Notes
Use notes to record user comments. You can add, edit, and delete notes.

Adding Notes (page 5-43)
Add a note to a Websheet page by clicking the Add Note icon (+) in the
Notes region.
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Editing or Deleting Existing Notes (page 5-43)
Edit or delete a note on a Websheet page by clicking its Edit Note icon.

5.14.3.1 Adding Notes
Add a note to a Websheet page by clicking the Add Note icon (+) in the Notes region.

To add notes to a Websheet page:

1. Log in to and run the Websheet.

2. Under Notes on the right side of the page, click the Add Note icon.

3. Enter text in the field provided.

4. Click Add Note.

5.14.3.2 Editing or Deleting Existing Notes
Edit or delete a note on a Websheet page by clicking its Edit Note icon.

To edit or delete existing notes:

1. Log in to and run the Websheet.

2. In the Notes region, click the Edit Note icon.

3. To edit file details:

a. Edit the fields provided. See item Help for more details.

b. To accept your changes, click Apply Changes.

4. To delete a note, click Delete.

5.14.4 Viewing and Deleting Annotations
Annotations include uploaded files, notes, links, and tags that were either added to a
Websheet page or to a specific row in a data grid. You can view and delete all
Websheet annotations on the Annotations page.

Accessing the Annotations Page (page 5-43)
Access the Annotations page by selecting Annotations in the View
menu.

Deleting Annotations (page 5-44)
Delete annotations from a Websheet by selecting Annotations from the
View menu then selecting items for deletion.

5.14.4.1 Accessing the Annotations Page
Access the Annotations page by selecting Annotations in the View menu.
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To access the Annotations page:

1. Log in to and run the Websheet.

2. From the View menu, select Annotations.

The Annotations page appears.

The Annotations page displays as an interactive report.

3. To view specific type of annotation, click the Files, Notes, Links, Tags, or Tag
Cloud tabs.

See Also:   

• Using Interactive Reports (page 3-1)

• Customizing an Interactive Report Using the Actions Menu (page 3-6)

5.14.4.2 Deleting Annotations
Delete annotations from a Websheet by selecting Annotations from the View menu
then selecting items for deletion.

To delete uploaded files, notes, link, or tags:

1. Log in to and run the Websheet.

2. From the View menu, select Annotations.

The Annotations page appears.

3. Select an annotation type by clicking the appropriate tab at the top of the page.

4. If not selected, click the View Report icon.

5. Click the appropriate tab: Files, Notes, Links, Tags, or Tag Cloud.

6. Select the annotations to delete.

7. Click Delete Checked.

5.15 Managing Websheet Applications
From a Websheet, you can change your Websheet password, email a Websheet to
another user, and print a Websheet.

Changing Your Websheet Password (page 5-45)
Change your Websheet password by selecting Change My Password in
the Administration menu.

Emailing a Websheet Page (page 5-45)
Email a Websheet page by clicking its Email icon (envelope) located near
the search bar.

Printing a Websheet Page (page 5-46)
Print a Websheet page by clicking the Print icon (printer) located near
the search bar.
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5.15.1 Changing Your Websheet Password
Change your Websheet password by selecting Change My Password in the
Administration menu.

To change your Websheet password:

1. Log in to and run the Websheet.

2. From the Administration menu, select Change My Password.

The Change Password page appears.

3. Follow the on-screen instructions and click Change Password.

5.15.2 Emailing a Websheet Page
Email a Websheet page by clicking its Email icon (envelope) located near the search
bar.

To email a Websheet page:

1. Log in to and run the Websheet.

2. Locate the page you want to email.

3. Click the Email icon above the Control Panel.

4. On the Email Page:

a. To - Enter the target email address.

b. Subject - Enter a description of this email.

c. Body - Enter the email content you want to include along with the Websheet
page link.

5. Click Send.

An email link to the currently selected page is automatically included in your email
message.

See Also:   

"Configuring Email" in Oracle Application Express Administration Guide
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5.15.3 Printing a Websheet Page
Print a Websheet page by clicking the Print icon (printer) located near the search bar.

To print a Websheet in printer-friendly mode:

1. Log in to and run the Websheet.

2. Click the Print icon above the Control Panel.

The page displays in printer-friendly mode.

3. Print the page.

5.16 Viewing Websheets
Use the options on the View menu to access presentation mode, view a page directory,
access a page history, and view an application directory.

About Presentation Mode (page 5-46)
You can use Presentation mode to view a single Websheet page as a
presentation. Each page section displays one at a time as a slide.

Viewing the Page Directory (page 5-47)
View the Page Directory by selecting Page Directory in the View menu.

Viewing Page History (page 5-48)
View the history of a page by selecting Page History in the View menu.

Viewing the Websheet Directory (page 5-48)
View the Websheet Directory by selecting Websheet Directory in the
View menu.

See Also:   

• Managing Annotations (page 5-39)

• Managing Data Grids (page 5-16)

5.16.1 About Presentation Mode
You can use Presentation mode to view a single Websheet page as a presentation. Each
page section displays one at a time as a slide.
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Users can navigate between sections by using the right and left arrow keys, by using
the right and left arrow controls on the top right of the page, or by entering a section
number to quickly jump to a specific section.

You can view a Websheet in presentation mode by clicking the Presentation icon (play
button) located near the search bar.

In Presentation mode, each page section displays as a separate page.

Use the navigation bar on the upper right of the page to scroll forward and backward
from section to section. To exit Presentation mode, click the Exit icon or press ESC.

5.16.2 Viewing the Page Directory
View the Page Directory by selecting Page Directory in the View menu.

The page history report shows old and new section content up to 4000 bytes. If the
content you want to view exceeds the length of the report display, you can also query
APEX$_WS_WEBPG_SECTION_HISTORY in your workspace schema.

To access the Page Directory:

1. Log in to and run the Websheet.

2. From the View menu, select Page Directory.

The Page Directory displays as an interactive report. To learn more about
interactive reports and using the Actions menu, see

By default, the Page Directory displays in icon view.

One page in each Websheet is designated as the home page. The home page is the
starting page that displays when you run the Websheet. In Icon view, the home
page displays as a page with an outline of home.

3. To view the page as a report, click the View Report icon.

By default, Report view displays the following columns: Name, Doc Type, Created,
Created By, Updated On, Updated By, Parent Page, and Grand Parent Page.

See Also:   

• Using Interactive Reports (page 3-1)

• Customizing an Interactive Report Using the Actions Menu (page 3-6)

Viewing Websheets

Using Websheets   5-47



5.16.3 Viewing Page History
View the history of a page by selecting Page History in the View menu.

The page history report shows old and new section content up to 4000 bytes. If the
content you want to view exceeds the length of the report display, you can also query
APEX$_WS_WEBPG_SECTION_HISTORY in your workspace schema.

To view the Page History report:

1. Log in to and run the Websheet.

2. Select a page.

3. From the View menu, select Page History.

The Page History displays as an interactive report.

A Search bar displays at the top of the page. Available controls include:

• Select columns to search - Resembles a magnifying glass. Click this icon to
narrow your search. To search all columns, select All Columns.

• Text area - Enter case insensitive search criteria (wildcard characters are
implied) to search for a page group by name and then click Go.

• Go button - Executes a search or applies a filter.

• View Icons - Displays each Websheet as a large icon.

• View Report - Displays each Websheet as a line in a report.

• Actions menu - Use the Actions menu to customize the report view.

4. To view changes in a Calendar format, click Calendar.

See Also:   Customizing an Interactive Report Using the Actions Menu
(page 3-6)

5.16.4 Viewing the Websheet Directory
View the Websheet Directory by selecting Websheet Directory in the View menu.

Use the Websheet Directory to navigate to another Websheet application.

To access the Websheet Directory:

1. Log in to and run the Websheet.

2. From the View menu, select Websheet Directory.

A Search bar displays at the top of the page. Available controls include:

• Select columns to search - Resembles a magnifying glass. Click this icon to
narrow your search. To search all columns, select All Columns.

• Text area - Enter case insensitive search criteria (wildcard characters are
implied) to search for a page group by name and then click Go.
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• Go button - Executes a search or applies a filter.

• View Icons - Displays each Websheet as a large icon.

• View Report - Displays each Websheet as a line in a report.

• Actions menu - Use the Actions menu to customize the report view.

3. To view a Websheet, do one of the following:

• In Icon view, click the appropriate icon.

• In Report view, click the Run icon in the Actions column.

See Also:   Customizing an Interactive Report Using the Actions Menu
(page 3-6)
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